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1Welcome to EverWeb

Welcome to EverWeb! 

In this chapter we introduce you to EverWeb and how to 
purchase the right product to suit your needs.

Welcome

EverWeb Software Only

EverWeb+Hosting

EverWeb Site Shield Addon

Contact Forms Enhanced Addon

Purchasing EverWeb
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Welcome To EverWeb! 

EverWeb is a complete drag and drop website building tool, letting you create 
professional, fast loading websites without any technical knowledge or coding 
skills. 

EverWeb not only makes it easy to create a website, but it also allows you to 
enhance your website with advanced widgets. You can use a widget to add E-
commerce features, Google Maps, Contact Forms, Facebook Like buttons and 
much more. 

EverWeb includes one click publishing to get your website online as fast as 
possible. 
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EverWeb Software Only & EverWeb + 
Hosting 

EverWeb comes in two versions: 

EverWeb Software Only (Standalone) 

EverWeb Software + Hosting 

Important 
No matter which version you choose to buy you will never lose access to the 
license you purchase, even if you do not renew your account. EverWeb is NOT 
a subscription service. 
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EverWeb Software Only 
EverWeb Software Only includes EverWeb software and one year of product 
updates and support.  

If you do not wish to purchase another year of upgrades and support, you can 
still use the version of EverWeb that you have already purchased. 

With EverWeb Software Only you will have to purchase web hosting separately. 

EverWeb Software Only costs $79.95 per license. 
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EverWeb + Hosting - starting at $99.95 
USD/year 
EverWeb + Hosting comes with the benefit of improved support and 
organization because everything related to your website goes through one 
company. EverWeb + Hosting also comes with these exclusive features: 

1. Lightning Publish: Publish up to 20x faster than with other web 
hosting providers 

2. Password protection of your entire, or parts, of your website 

3. 404 Page Not Found redirects so your visitors won’t see 404 error 
pages if they visit and outdated link 

4. 301 redirects to redirect old web pages to your new EverWeb website 
and retain your search engine rankings 

5. Free software updates with an active account 

6. 24/7 Phone & Email Support with an active account 

7. Free Website Stats 

8. Faster Website previews and publishing 

9. One-Click SSL Certificate for HTTPS Secure URLs with EverWeb Site 
Shield 

The EverWeb + Hosting version also lets us more efficiently help you should 
problems arise because we have access to the server that your website is on. 
You only have to deal with one company for any of your website issues. 

EverWeb + Hosting starts at $99.95 USD / Year.  
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EverWeb Site Shield Addon 
EverWeb Site Shield Addon helps protect your website and improves its 
ranking on Search Engine Results Pages (SERP). Google and other search 
engines give a SERP boost to websites that use HTTPS instead of just HTTP. 
Websites using HTTPS display a secure padlock symbol in the web browser’s 
path bar. 

Why HTTPS is Important 
Using HTTPS is important for your website as: 

• All data is ‘End to End’ is encrypted from your visitors computer to your 
website. 

• Your website is safer for your visitors. 

• Your website’s credibility is improved with a "secure lock" notice 

• Google and other search engines place HTTPS websites higher in their 
rankings than HTTP websites. 

Normally, changing your website from HTTP to HTTPS can be a difficult 
process. However, with EverWeb Site Shield Addon we make this change very 
easy - just tick one checkbox to change your website from HTTP to an HTTPS 
secure website. Your HTTPS website will be highly optimized for search 
engines and protecting your website visitors at the same time.  

EverWeb Site Shield Addon is exclusive to EverWeb + Hosting accounts.  

EverWeb Site Shield is free if you have an EverWeb + Hosting 10GB or higher 
plan.  

If you have an EverWeb + Hosting 2GB plan you can purchase EverWeb Site 
Shield for just $29.95 USD / Year. 
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EverWeb Standalone users must work with their web hosting provider to set 
this up. 

Adding EverWeb Site Shield Addon 
To add EverWeb Site Shield Addon follow these steps or click this direct link; 

1. Login to your Client Area 

2. Select ‘Services’ from the menu and click on ‘View Available Addons’ 
from the navigation bar 

3. You will see the available ‘Add Ons’ on the next page in the ‘Product 
Addons’ section of ‘Categories’. 

4. Select the ‘Addon’ and follow the purchasing steps. 

Enabling HTTPS Websites in EverWeb 
To use EverWeb Site Shield Addon for your website: 

1. Go to the Site Publishing Settings of your website project file using the 
File -> Edit Publishing Settings menu option. 

2. Tick the ‘Use HTTPS Secure URLs’ box. 

3. Publish your website.  

It is recommended that you publish your entire website (using the File -> 
Publish Entire Site menu option) so that all necessary link structures in your 
website are properly re-published. 
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Contact Forms Enhanced Addon 
EverWeb’s Contact Forms Enhanced is an add on for the Contact Form 
Advanced widget. Contact Forms Enhanced has the following features: 

• A login area to review all form submissions 

• Search and manage all form submissions online 

• Select the data you want to use quickly and easily 

• Export form submission data in CSV file format 

• Website visitors can upload files in Contact Forms to a safe, secure area 
in your Client Area 

• Download files that your visitors have sent you from your Contact 
Forms  

The Contact Forms Enhanced Advantage 
You can use the Contact Forms Enhanced Addon to collect form submissions 
that can be used for creating email address lists for electronic newsletters, 
track responses to your events, promotions and surveys, keep your existing 
client base regularly updated with your current business activities and keep 
track of potential new customers.  

The Contact Forms Enhanced Addon can help you retain existing customers 
while growing your business with potential new customers. 

The Contact Forms Enhanced Addon makes it easy for you to download the 
data from your form submissions. In addition you can also receive file uploads 
from your website visitors that you can then download from your EverWeb 
Client Area, safely and securely. 
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Purchasing Contact Forms Enhanced Addon 
You can purchase the Contact Forms Enhanced Add-on safely and securely 
from our Secure Online Store. 

You can always upgrade/downgrade between packages if you need more form 
submissions or file upload space. 

Contact Forms Enhanced Addon Pricing 
Contact Forms Enhanced is available in two configurations: 

1,000 Form Submissions + 1GB File Upload Space 

•  Only $29.95 USD /Year 

•  Only $54.95. USD / 2 Years (8% discount) 

•  Only $79.95. USD / 3 Years (20% discount) 

10,000 Form Submissions + 10GB File Upload Space 

•  Only $49.95 USD / Year 

•  Only $94.95. USD / 2 Years (5% discount) 

•  Only $139.95. USD / 3 Years (14% discount) 
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Purchasing EverWeb 

Quickly and easily purchase EverWeb by following the link below. Licenses are 
immediately delivered so there’s no wait in getting your website online! 

Purchase an EverWeb License 
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Custom Designed, Professional 
Websites 
If you are having trouble designing your website, or want a custom designed, 
professional website designed for you, we can help! 

Get a professionally designed website that you have the ability to update and 
change whenever you need. 

We provide three levels of design services to fit your budget which include; 

1. Converting an existing website design to EverWeb 
This option is a low cost solution to take a pre-existing design and turning 
into an EverWeb website that you can then update and modify 

2. Creating a completely unique, custom design that fits your needs 
This option is great if you need a low cost, professionally designed website 
that you can edit and modify in EverWeb and you already know what style 
you want 

3. Providing a minimum of 10 unique website designs that you can 
choose from 
This option is great if you are not sure what you are currently looking for in 
your website design and want at least 10 unique designs to choose from. 
Once you choose a design we have created for you, we turn it into an 
EverWeb project you can then modify and enhance to your needs 

Every package above comes with a professionally created EverWeb project file 
that you can then take and modify for yourself. 

For more details and pricing for these designs, please visit our custom design 
website or contact customer support for more details. 
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2Getting Started

In this chapter you will learn about the Projects Window, 
create your first website project and find out how to get 
help at any time if you need it.

The Projects Window

Creating a New Website Project

Selecting Your Website Project Style

Creating Your First Page

Getting Help
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Getting Started 
The Projects Window 

The Projects Window is the first screen you see when you launch EverWeb (see 
Figure 2.1). The Projects Window is where you: 

• Create new website projects 

• Open an existing website project by double clicking on its name in the 
Recent Projects list 

• Perform administration tasks relating to your website project files. 

If at any time you need to access the Projects Window, just use the File-> 
Projects Window... menu command. 
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Projects menu. It lists your current websites and lets you create new websites.
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Creating a New Website Project 
You can use the Projects Window to create a new website. The Projects 
Window has two buttons on left hand side (see Figure 2.1): 

• ‘Create a new website’: Click this button to create a new website 
project in EverWeb 

• ‘Learn How to use EverWeb’: Takes you to the EverWeb Video Tutorial 
Library. 

The right hand side of the Projects Window lists the website project(s) you 
have already created in the ‘Recent Projects’ list. If you do not have any saved 
projects, this list will be empty. For now, double click on the ‘Create a new 
website’ button to create a new EverWeb Project file. 

Creating Your First Page 
When you create a new website project, the first page of the project is created 
at the same time. Whenever you add new pages (or directories) to your project, 
the Theme Template Chooser will appear (See Figure 2.2). 
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Figure 2.2: The Theme Template Chooser is where you select the page style you want to use for your 
website. If you are building your website from scratch use the Blank, or Blank Responsive, template.



EverWeb User Manual Getting Started: The Projects Window

Selecting Your Website Project Style 
EverWeb’s Theme Template Chooser lets you add pages to your website 
project that are either:  

• Fixed Width or 

• Responsive 

A Fixed Width website design is one where the width of the web page is fixed. 
Desktop and tablets typically use a page width of about 1000 pixels, whilst 
mobile devices typically use a page width of about 320 pixels. Therefore you 
will need to design one page for desktop/tablet devices, and a corresponding 
page for mobile devices. 

A Responsive page layout automatically adjusts to the device that the page is 
being browsed upon. As the page design automatically scales to suit the 
device it is being used upon, only one web page design is needed. 

There are advantages and disadvantages to either style and these are 
discussed in the Responsive Websites in EverWeb chapter. 

This manual explores EverWeb’s features using a Fixed Width website layout as 
it makes exploring EverWeb’s features and web design concepts easier if you 
are new to EverWeb. The features explored in the following chapters can also 
be used in responsive website designs, unless where noted.. 

For more information about creating responsive websites in EverWeb please 
refer to the chapter Responsive Websites in EverWeb.. 
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Selecting a Theme Template and Page Style 

EverWeb’s Theme Template Chooser lets you select the style of your website 
project from over 150 professionally designed Theme Templates. Themes are 
listed in the left hand column with their corresponding page styles displayed 
on the right.  

To add a new page to your Project file: 

1. If this is the first page you are adding to your Project file, go to the next 
step. If you already have one, or more, pages in your Project and want 
to add a new page, click on the Add Page button in the Toolbar. 

2. You can filter the type of Theme Template that you want to see using 
the ‘Filter’ drop down menu in the top left corner of the Theme 
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Figure 2.3: The Theme Template Chooser showing the Filter dropdown menu in the top left corner. Use 
the Filter to display All Themes or either only Fixed Width, Responsive or New Theme Templates.
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Template Chooser (see Figure 2.3 above). You can select to view either 
Fixed Width, Responsive, New or All of the themes.  

3. Scroll down the list of themes in the left hand column and click on the 
theme that you want to use. If you already know the name of the 
Theme Template you want to use, just start typing its name e.g. 
‘Wedding’. As you type, EverWeb will use predictive search to take you 
to the theme as you type. 

4. If building your website from scratch, use the Blank Theme Template 
(for Fixed Width websites) which is the first theme in the list, or the 
Blank Responsive Theme Template for blank responsive page styles. 

5. When you click on the Theme Template to select it, the right hand side 
of the Theme Template Chooser will display the page styles associated 
with the theme. 

6. Click on the page style you want, then click on the ‘Select’ button.  

7. The Theme Template will be downloaded to your computer if it is the 
first time that you selected the theme.  

8. Some Theme Templates use Google Fonts e.g. the ‘Apollo’ theme. 
When the Theme Template downloads, you will be asked if you want to 
use the Google Font(s) that belong to the theme. It is recommended 
to do so. 

9. Your new page will be added to the website project and displayed on 
screen. The page is also added to the list of pages in the Web Page List. 

Adding New Theme Templates 
New Theme Templates are regularly added to EverWeb. To check if any new 
Theme Templates are available use the EverWeb -> Check for New Templates 
menu option.  

Alternatively, when you add a page to your project file, you can use the ‘Check 
for New Templates…’ button in the top right hand corner of the Theme 
Template Chooser (see Figure 2.3).  
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EverWeb will check for new Theme Templates to install. A dialog box will 
appear listing any new Theme Templates that are available (see Figure 2.4). By 
default, all new Theme Templates are checked for downloading. Uncheck the 
box to the left of any Theme Template that you do not want to download. Use 
the Settings Cog to select ‘All’ available Theme Templates or select ‘None’ to 
deselect all Theme Templates. To help refine your download selection, use the 
‘Preview’ button view a preview of the Theme Template’s Home page.  

When you have chosen your Theme Templates to download, press the 
‘Download’ button. 

Any new Theme Templates added to EverWeb since the last update are 
marked with a ‘New’ indicator in the Theme Templates list (see Figure 2.2). 

Congratulations! You have now created your website project file and its first 
page! 
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download. Use the Preview button to view a preview of the associated Theme’s Home page.
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Getting Help 
Help is available at any time in EverWeb.  

To access EverWeb video tutorials either use the ‘Learn how to use EverWeb’ 
button on the Projects Window, or the Help-> Video Tutorials menu.  

Video tutorials relating to specific EverWeb features are shown by 
the Video Help ‘?’ button next to the feature. Click on the button to 
access the feature you want help with. 

If you want to access this User Manual at any time, click on the ‘EverWeb 
Manual’ link below the buttons on the Projects Window, or use the Help-> 
EverWeb Manual menu. 

If you cannot find the help you need, or have a question about EverWeb that is 
not covered in this manual or the video tutorials, please use one of the 
following resources: 

• The EverWeb website at www.everwebapp.com. 

• The EverWeb Knowledgeable at http://billing.ragesw.com/
knowledgebase.php 

• The EverWeb Discussion Forum at http://billing.ragesw.com/forum.php 

If you have a valid support plan you can also call, email or chat with an 
EverWeb Expert, live, 24 hours a day, seven days a week, 365 days a year at 

EverWeb Support: 1-888-500-2901  
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3The EverWeb User 
Interface

In this chapter you will find out all about the Project 
Window which has four sections that make up EverWeb’s 
User Interface.

The EverWeb User Interface
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The EverWeb User Interface 

You have now successfully created your website project file and its first page. 

Before starting to build your website, it is important to become familiar with 
EverWeb’s User Interface, known as the Project Window (see Figure 3.1) which 
should not be confused with the Projects Window (Figure 2.1 above). 
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Figure 3.1: EverWeb’s User Interface consists of four main sections. Not pictured are the Assets and 
Widgets windows, which can be accessed by clicking on the tabs labeled Assets and Widgets respectively.
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There are four main areas of the Project Window: 

• The Web Page List (see Figure 3.1 - Section A), is where all of your 
website's pages are listed. You can adjust the width of this area by 
hovering your cursor over the divider, and then clicking and dragging 
to the left or right. 

• The Toolbar (see Figure 3.1 - Section B) at the top of the Project 
Window allows you to quickly access often performed tasks such as 
adding a new page, shape, or text box to the Editor Window. 

• The Inspector Window (see Figure 3.1 - Section C) on the right hand 
side of the Project Window consists of three tabs containing all of the 
features to modifying elements of your website: 

• The Inspector tab, shown in Figure 3.1, allows you to control Page 
Settings, Shape Options, Object Metrics, Text properties, 
Hyperlinks and Widget Settings. 

• The Assets tab is used for managing your website's images and 
media files. 

• The Widgets tab contains mini apps known as ‘Widgets’ for easily 
adding extra features you may want to your website.  

• The Editor Window is the area in the middle which is your design 
canvas (see Figure 3.1 - Section D) where you create or modify your web 
pages. 
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4The Editor Window

In this chapter you will learn about the Editor Window, 
which is your work canvas, and how to add, edit and delete 
objects on your page.

The Page Layout

Adding Objects To The Editor Window

Moving Objects

Aligning and Distributing Objects

Finding the Distance Between Objects

Deleting Objects
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The Editor Window 
The Page Layout 
You can design your entire website just by dragging and dropping text, 
images, shapes, audio, video and widgets on to its design canvas which is 
known as the Editor Window.  

The text, images, media, widgets and other content that you add to your page 
are known as objects, and we will explain how to manipulate objects later on 
in the chapter.  

First, let’s look at the Editor Window which has the following main sections: 

• The Header (Fixed Width layouts only) 

• The main body (content) area 

• The Footer. 

The sections of a page are much like those in a book. The Header usually 
contains relatively static content that you always want displayed at the top of 
most, if not all, of your pages , for example a company logo, social media icons 
and a navigation menu.  

Note that responsive websites do not have a Header section but Fixed 
Width page layouts do. 

The main body, or content area, is where you place objects specific to the page 
itself e.g. on an ‘About Us’ page, you might include text about your company’s 
mission statement, a company video, image slideshow etc. 

The Footer is like the Header in that it usually contains relatively static content. 
However, Footer content often provides your visitor with further help such as a 
site map of your website, social media buttons and contact information. The 
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Footer is also, for example, where copyright information and any legally 
required text is often placed. 

By default, the page layout of the Editor Window shows each section with blue 
borders separating each section. You can toggle the page layout display on or 
off using the Window ->Show Layout menu option.  

The default height of the Header, main body and Footer are set in the Page 
Layout section of the Page Settings tab of the Inspector tab (see Figure 3.1 - 
Section C). When you add objects in to a section, the height of the section will 
automatically adjust as necessary to accommodate the object.  

This approach allows you to design each section of your page while making 
sure enough room is provided for the Header, content and Footer. It also 
means that you do not have to rearrange objects every time you want to 
modify a section.  

If the content of your Header and/or Footer will be the same on many, or all, of 
your pages consider using a Master Page instead. , 

Note: The remainder of this chapter explains how to work with objects in the 
Editor Window. Objects in Responsive websites are manipulated differently 
due to the nature of responsive design. Please refer to the Chapter Responsive 
Websites in EverWeb for more information. 
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Adding Objects To The Editor Window 
You can start working on your web page by, for example, adding a TextBox or 
Shape from the Toolbar. We will discuss other objects such as images and 
other media in later chapters.  

The TextBox or shape will be created in the main body of the Editor Window. 
You can move the object to another location in the main body area by clicking 
and dragging it to where you want to place it, then releasing the mouse 
button. 

As you move the object around the main body area, notice that it may bump 
up against the bottom of the header area and that when you move the object 
the area towards the footer, the main body area’s height automatically adjusts 
the main body space to accommodate. 

Selecting and Resizing Objects 
When you click on an object, such as a TextBox, shape or image, you will see 
that it will have an outline around it with small square boxes at each corner 
and at the center of each edge. These squares are called selection (or grab) 
handles.  

As well as showing that the object is selected, you can use the grab handles to 
resize the object. Click and hold the mouse pointer on the grab handle you 
want to use and then move the mouse cursor to increase or decrease the size 
of the object. 

Moving Objects Between Editor Window Sections 
As you may have noticed, when moving an object around the Editor Window, 
you cannot move the object between sections. To move an object from one 
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section to another, hold down the COMMAND key on your keyboard as you 
drag the object into another section. Release the COMMAND key when the 
object is in the next section. 

If you don’t want an object to be able to affect the height of a section go to 
Inspector->Metrics and select the ‘Allow free dragging’ option. Now the object 
can be dragged anywhere on the Design Canvas without affecting the height 
of each section. 

Moving Objects Obscured by Other Objects 
As you design your web pages, you may sometimes have one or more objects 
overlapping other objects. To easily move an object that is covered without 
affecting covering objects: 

1. Select the object you want to move.  

2. If you have difficulty selecting the object you want, secondary click on 
the object that covers the object you want to select. 

3. A sub menu appears. Scroll down to the Pick Layer option. This will 
show you all of the objects that are positioned at the location you 
clicked on. 

4. Select the object you want from the list. Your object is now selected. 

5. Next, hold down the Command+Option keys and drag the object you 
want to its new location. 

Moving Objects Whilst Retaining the Page Layout 
There may be times where you want to insert an object, such as an image, in to 
your page but you need to create the space on the page in order to drop the 
image in place.  
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To make the space for your image on the page, you may need to move existing 
content down the page in order to drop the image in to the right place  

EverWeb allows you to easily move the objects below where you want the 
image down all at the same time, so preserving the page layout 

1. Select the first object that is directly below where you want to insert 
the image. 

2. Hold the Shift+Command keys down and drag the object down the 
page. 

3. The selected object, and all objects below it, will move down the page 
at the same time preserving the page layout. 

4. Once you have created enough space, release the keys and mouse 
then drag and drop the image in to the space you have just created. 

If you use the Shift+Command keys whilst resizing an object, the objects below 
the selected object will move down. 
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Aligning Objects 

When building your website, it is important to position text, shapes and 
images exactly where you want them to be. There are different ways in which 
you can position these ‘objects’. For example, to center an object on the page, 
first select the object. Next, go to the Arrange > Align Objects menu option 
and then select Center. The object is centered. 

Likewise, you can do the same if you want the object to be left aligned, or right 
aligned. You can also specify if you want the object to be placed at the top of 
the page, the bottom of the page, or directly in the middle of the page (see 
Figure 4.1.) 

Distributing Objects 
Let's say you have multiple objects beside one another and you want to space 
them evenly. Select all the objects either by using your mouse, or by selecting 
each object while holding down the Command key on your keyboard. Then go 
to Arrange > Distribute Objects > Horizontally (see Figure 4.2). 
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Figure 4.1: Object Alignment
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If the objects were placed vertically, repeat the above steps but but select 
‘Vertically’ instead. 
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Figure 4.2: Multiple objects can be distributed evenly either horizontally or vertically.
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Finding The Distance Between Objects 
When designing your web page, sometimes it is useful to find the distance 
between objects on the page. To do this 

1. Select the source object 

2. Hold the Option (Alt) key down. 

3. Mouse over the target object(s) to see the distance in pixels between it 
and the source object. 

Deleting an Object 
If you want to delete an object from the Editor Window, first select the object 
so that you see the grab handles around it, then press the backspace key on 
your keyboard to delete the selected object. 

If you have deleted the object by mistake, press Cmd+Z immediately to undo 
the deletion. 

Customizing The Editor Window 
The Editor Window’s appearance can be customized using the options on the 
Window menu. Hiding the Toolbar and/or the Inspector will give you more 
screen space for the Editor Window.  

Options specific to the Editor Window itself include Hide/Show Layout which 
toggles the display of the blue guide lines on and off.  

The Hide/Show Rulers option toggles the display of the Editor Window’s 
horizontal and vertical rulers guides (measured in pixels) on and off.  
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Hide/Show Breakpoints toggles the display of the vertical line guides denoting 
the maximum width of mobile, tablet, desktop and large desktop on and off.  

The Hide/Show Hidden Objects toggles the display of objects that have been 
hidden using the Metrics Inspector on and off. 
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5The Web Page List

The Web Page List is where you organize your pages, It is 
also the place where you create Master Pages and 
Directories that can be used to create Navigation Menus. 

The Web Page List

Naming Your Project, Directories and Pages

Adding Pages and Directories to Your Website Project

Creating a Navigation Menu

Creating a Simple Navigation

Creating a Dropdown Navigation

Creating a Responsive Navigation

Formatting & Styling the Navigation
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The Web Page List 

On the left hand side of EverWeb’s User Interface, is the Web Page List where 
you will see the name of your website project and any directories and web 
pages you have created listed beneath it (Figure 5.1). 

Each page or directory you create has an icon next to it: 

A white icon indicates that the page, or directory, has not been modified 
since the last time you published the site. 

A red icon indicates that the page, or directory. has been modified since 
the last publish and will need to be published again for the changes to 
be reflected online. 
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Figure 5.1: The Web Page List is located on the left hand side of the application. Red icons indicate a 
modified page, a grey icon indicates no modifications have been made.
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Naming Your Website Project, Directories 
and Pages 
You can change the name of your website, its directories and web pages in a 
number of different ways: 

• Double clicking with Mouse or Trackpad 

Double click on the website name, directory or page name in the 
Web Page List. Edit the name and press enter to finish. You can also 
use double click to rename blog post names and assets in the Assets 
List. 

• Using The Menu Options 

You can use the File-> Rename Website menu option to rename your 
website. 

Use the File-> Rename menu option to rename the currently 
selected directory or web page. You can also use this menu option to 
rename assets and blog posts. 

• The Inspector Tab 

Web pages and directories can also be renamed by clicking on the 
Page Settings button in the Inspector tab, then changing the page 
name using the ‘File Name’ option. 
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Adding Pages To Your Website Project 
To add pages to your website click on the ‘Add Page’ button in 
the Toolbar. Select the new page theme and page style that 
you want to add as described above. 

The new page will appear in the Web Page List. 

Duplicating Pages 
If you want to add a page that looks identical to one of your pages, secondary 
click on the page name in the Web Page List that you want to copy, and select 
‘Duplicate’ from the menu.  

Duplicating a page is essentially copying an entire page.  

If most of your pages will be using a similar design, it’s best to use EverWeb’s 
Master Pages feature as this will save you time and effort. 

Deleting Pages 
To delete a page from your Project, select the page in the Web Page List. Right 
click on the page. From the submenu select the ‘Delete Page’ option. You will 
be warned that you are about to delete the page before the deletion unless 
you have previously turned this warning message off. 
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Adding Directories To Your Website 
Project  

Using directories is a good way to organize your website 
pages. Directories are also used as the basis for Dropdown 
Navigation Menus. 

To add a new directory to the Web Page List: 

1. Click on the ‘Add Directory’ button in the Toolbar. 

2. Select the Theme Template you want to use from the left hand 
column. 

3. Select the page style you want to use from the right hand side of the 
Theme Template Chooser.  

4. Click’ Select’ to add the directory page to the Web Page List.. 

The new page has a folder (directory) icon instead of the normal page icon. 
Remember, the directory page is still a page on your site, so you will need to 
treat it like any other page. 

To add pages within this directory, simply select the directory in the Web Page 
List, and click on the ‘Add Page’ button. A page is created within the directory 
and is displayed below, and a little to the right of, the directory, 

If you hover your mouse over the directory page in the Navigation Menu in the 
Editor Window, you will see the dropdown menu displayed. 
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Moving Pages In and Out of Directories 
To move a page in to a directory, click and drag the page you want to move on 
the directory folder. When you see a line with circle at the left hand end 
positioned just below and to the right of the folder, drop the page in place. 

If the folder is closed, you will not see the page placed in the folder. To open 
the folder to see its contents, click on the arrow to the left of the folder name. 

When the folder is open you can move pages out of the folder. Just click and 
drag the page you want out of the folder and to its new location and drop in 
place. 
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Creating a Navigation Menu 
EverWeb’s Web Page List is used as the basis for your website’s Navigation 
Menu.  

The order of the pages in the Web Page List from top to the bottom 
determines the order that your Navigation Menu items are displayed from left 
to right. 

You have three different styles of Navigation Menu styles to choose from for 
your website: 

• A Simple Navigation Menu 

• A Dropdown Navigation Menu 

• A Responsive Navigation Menu 

Note: When we mention ‘Navigation Menu’ we are referring to EverWeb’s built in Navigation 
Menu widget. The Navigation Menu widget itself is discussed in detail later on. 

Only pages that have ‘include page in navigation menu’ ticked in the Page 
Settings of the Inspector Window are included in the Navigation Menu. 

Adding the Navigation Widget To Your Page 
To add the Navigation Menu widget to your page select the Widgets Tab and 
drag and drop the Navigation Menu widget on to the page. Usually the widget 
is placed in the Header section of your Master page. Please refer to the Master 
Pages section for more information about how to create ‘template’ Master 
Pages for your website. 
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Creating a Simple Navigation Menu 
When you add the Navigation Menu widget to your page you will see that it 
includes all the pages from the Web Page List that have ‘include page in 
navigation menu’ ticked. 

The above example is a Simple Navigation Menu as all the menu options are 
on one line only. As you can see, this menu style may have too many items in it 
to be easy for your visitors to use (see Figure 5.2).  

It may be better to simplify the Navigation Menu by structuring the menu so 
that it includes dropdown items instead. 
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Figure 5.2: Navigation menu in EverWeb. Note the links for “For Sale” and “For Rent”
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Creating a Dropdown Navigation Menu 
It also keeps the Navigation Menu easy for your visitors to navigate 

The directory structure is also used to generate dropdown Navigation Menus 
(see Figure 5.3). 

. 
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Figure 5.3: Dropdown navigation menu in EverWeb. The “For Sale”  & “For Rent” links are now in a dropdown menu.
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Creating a Responsive Navigation Menu 
Both Simple and Dropdown Navigation Menu 
styles can be incorporated in to a Responsive style 
Navigation Menu. 

A Responsive Navigation Menu will adapt to the 
width of the device you are using e.g on a desktop 
you may want to see a Simple or Dropdown 
Navigation Menu. On a mobile device where space 
is limited you may want to use a ‘Hamburger’ style 
Navigation Menu instead. 

To make your navigation responsive:  

1. Add the Navigation Menu widget to your 
page. 

2. With the widget selected, go to the 
Widget Settings tab in the Inspector 
Window. (see Figure 5.4) 

3. Scroll down to the Responsive Options 
section. 

4. Tick the box for ‘Responsive Navigation 
Bar’. 

Beneath the ‘Responsive Navigation Bar’ option is 
the ‘Appear at Width’ option which is set to 700 by 
default. When the screen width is less than 700 
pixels, the Navigation Menu will become a 
Hamburger style menu. 

You can test this out by resizing the width of the 
EverWeb application. Click and drag the right 
hand edges of the EverWeb UI to the left. At 700 
pixels wide, you will see the Navigation Menu 
change to a Hamburger style menu. 

Note: Responsive Navigation Menus can be 
used in both Fixed Width and Responsive 
website designs. 
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Figure 5.4: Navigation Menu 
Widget Settings showing 

Responsive Options.
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Formatting The Navigation Menu 
By default, the Navigation Menu label for each page is its ‘File Name’ as shown 
in the Web Page List and in the Page Settings tab of the Inspector Window. 

As File Names can only consist of letters and/or numbers, use the Navigation 
Display Name field in the Page Settings tab of the Inspector Window to 
override the File Name label in the Navigation Menu. You can use any label you 
want for the Navigation Menu. 

There are many ways in which to customize the Navigation Menu. First select 
the widget, then: 

• Change the Navigation Menu font and style using the Text tab in the 
Inspector Window or by using the Fonts button in the Toolbar. 

• Change the background appearance of the top level menu items 
using the ‘Fill’ section of the Shape Options tab in the Inspector 
Window. 

• Use the Widget Settings tab to change the background colors of 
dropdown menu items. 

• For a Responsive Navigation Menu, use the Widget Settings and tick 
the ‘Responsive Navigation Bar’ option. You can now set when to have 
the Hamburger menu icon displayed. By default this is set at a width of 
700px. Change the Responsive Options and Hamburger Button 
options as desired. The options also allow you to change the 
Hamburger icon color and background as well as the menu label and 
its font style, size and color. 
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6Master Pages

Master Pages are template pages you create yourself to 
use on some, or all, of the pages in your website project.  

Add features such as a navigation menu, social media 
icons, a logo etc. just once to a Master Page. Any pages 
using the Master Page will inherit its features 
automatically so updating pages is quick and easy in 
future.

Master Pages

Creating a Master Page

Using Master Pages
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Master Pages 

Master Pages are template pages you create that can be used on some, or all, 
of the pages in your website project.  

Master Pages save time and effort as you only need to add features such as 
navigation menus, social media buttons, company logos etc. once to the 
Master Page. Any pages using the Master Page will inherit its features 
automatically making updating pages in your Project quick and easy in future. 
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Creating a Master Page 

To create a Master Page, click on the ‘New Master Page’ button (highlighted in 
Figure 6.1). 

If the Master Pages List is not visible, drag the splitter bar at the top of the Web 
Page List down to reveal the section. 

 The Theme Template Chooser appears. Add the page style that you want to 
use as a Master Page in the same way as you would for a regular page. 

Creating a Master Page is just like creating a regular page. You can design it 
however you like, adding shapes, text or images. 

You can have as many Master Pages as you want. For example, you can create 
a Master Page for your desktop site and another for your mobile site. 

Note: You cannot make a Master Page from the ‘blog’ Theme Template. 
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Figure 6.1: Quickly add a Master Page to your website using the ‘New Master Page’ button.
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Using Master Pages 

Once you have created your Master Page, you need to assign it to your web 
pages. 

To do this, select your page in the Web Page List on the left hand side.  

In the Inspector Tab on the right hand side, select the Master Page you want to 
use for that page as shown in Figure 6.2. 

The web page will now reflect the design of the Master Page.  

You can also add new shapes, text or images to the web page to enhance the 
design of the page. 

To see which objects are part of the Master Page, and which are part of the 
web page you are working on, use the Window-> Show Layout menu. 

Objects that belong to a Master Page have a small, black page icon next to 
them and can only be edited from the Master Page itself. 
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Figure 6.2: To add a Master Page to your web page, select it from the drop down menu in the Page 
Settings tab as shown above.
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Master Pages usually (but not always) contain objects such as social media 
buttons, company logos, navigation menus etc in the Header and Footer 
section as these objects usually appear on many, if not all, of your pages  

The actual content of each individual page is usually added between the 
Header and Footer sections of the page itself, rather then in the Master Page 
as this content is generally only intended to be one one page only. 

For your Master Page, you can set a small Content Height under Inspector-> 
Page Settings-> Page Layout section. On your actual pages, any content you 
add will push the height the content area down. In this way, you can fit any 
amount of content in to your page. 

You will notice that you can’t explicitly set the content height of each page that 
uses a Master Page. As noted above, as you add objects to the content area of 
your actual pages, the content area will expand to a longer size to 
accommodate them. 

When working with Master Pages, remember to: 

1. Set ‘Content Height’ at about. 100 pixels i.e. the minimum height any of 
the pages using the Master Page. Set Content Height from the 
Inspector-> Page Settings-> Page Layout section. 

2. Use a Master Page to design a common Header and Footer for your 
pages. 

3. You can create multiple Master Pages. For example one for desktop 
pages and one for mobile pages 

4. You cannot explicitly set the height of each section on the actual pages 
that use your Master Page. Objects that you add to each section will 
adjust the height as needed to accommodate them, allowing you to 
pages with dynamic heights while still sharing the same Master Page 

5. Use the Window-> Show Layout menu to see which objects are from 
your Master Page. Master Page objects have a small, black file icon in 
the top right corner. Edit the Master Page to adjust any of these 
objects. 
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7The Toolbar

The Toolbar at the top of the EverWeb User Interface gives 
you quick access to many commonly used EverWeb 
features.

The Toolbar
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The Toolbar 
 

The Toolbar (see Figure 7.1) lets you quickly access common tasks such as 
adding new pages, shapes or text, change text fonts and more.  

• Add Page: Opens the Theme Template Chooser and lets you add a 
new page to your website based on a template or with a blank page 

• Add Directory: Directories are folders containing web pages. They are 
used to organize your website and for dropdown navigation menus. 

• Preview: Preview your website to any of the web browsers installed on 
your local computer. 

• Publish: Publishes your website to the Internet or to a folder location. 
Please refer to the Publishing chapter for more information. 

• TextBox: The button lets you add text to your page. Text can be 
formatted and positioned anywhere on your web page. 

• Shapes: EverWeb’s built in Shapes help you design your website. 
Shapes can have solid colors, gradients or images. See the Shape 
Options section for more information about customization options. 

• Scroll Position: Easily set up ‘anchors’ so you can hyperlink from any 
object to a specific location on any page in your website. See the 
section on the Hyperlinks Inspector for more information. 

• Rotate: This option rotates the selected shape 90 degrees clockwise. 
Hold down the Option (Alt) key to rotate the shape counter clockwise. 

• Mask: Quickly display only the part of the selected image you want to 
see. Masking is similar to cropping but is not destructive to the image 
itself. 

www.everwebapp.com  of 56 207

Figure 7.1: The Toolbar gives you quick access to frequently used EverWeb features



EverWeb User Manual The Toolbar

• Fonts: The Fonts button opens the Font Panel and lets you modify the 
selected fonts of any selected TextBox. 

• Colors: The Colors button opens the Color Picker and lets you change 
the text color of any selected text and the color of any selected shape. 

• Media: Allows you to access EverWeb’s Free Stock Photos library and 
the Media Browser. 
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8The Inspector 
Window

The Inspector Window has six tabs that are used to set  

Note: page layout defaults and various parameters for 
objects that have been placed on the Editor Window. 

Page Settings

Shape Options

Metrics Inspector

Text Inspector

Hyperlinks Inspector

Widget Settings
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The Inspector Window 
Page Settings 
Page Details 
The first tab in the Inspector Window is 
the Page Settings tab. Here is where 
adjustments to the settings for each 
page on the website are made.   

The first option on the Page Details tab 
(Figure 8.1) is ‘File Name’.  

The File Name is what you see in your 
web browser's address field. e.g. you 
may want to name the page after its 
function such as Home, About Us, 
Contact Us, Services, Products, etc.  

As you change the File Name, the 
changes also appear in the Web Page 
List.  

The page’s File Name is one of the topics 
discussed in the SEO For EverWeb Video 
Course. 

If Search Engine Optimization is important for your website, please look at the 
tutorials before assigning your web page's file names. 
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Figure 8.1: The Page Details section on the Page 
Settings tab.
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The ‘Language’ drop down is used for Search Engine Optimisation (SEO) 
purposes. For example, if your website is designed for Canadian visitors only, 
you may have most of your pages in English but some in French to cater for 
both types of visitor you want to attract.  

In this example, use the ‘Language’ drop down to select ‘English Canada’ for 
your English language pages and ‘French Canada’ for your French language 
pages.  

Google and other search engines will use this information to serve the 
appropriate content when a person performs a relevant search.  

If you only use one language in your website, use the File-> Edit Publishing 
Settings menu to globally set the ‘Language’ to the one you are using. 

The ‘Navigation Menu Display Name’ is the text that appears in your navigation 
menu if you use EverWeb's built in Navigation Menu Widget.  

The Navigation Menu Display Name is another elements to optimize for search 
engines as shown in the SEO For EverWeb Video Course. 

The Navigation Menu is discussed in more detail later in the User Manual and 
in EverWeb’s Video Tutorials which can be accessed from the Help-> Video 
Tutorials menu.  

You have the option of including each page of your site in the navigation 
menu. By default, each page is included in the navigation menu, If you do not 
want this, uncheck the ‘Include page in navigation menu’ option. 
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The ‘Web Page Title’ appears at the top of your page in the web browser. The 
Web Page Title is another element to optimize for search engines. The video 
tutorials, again, has extensive information making a good page title. Web page 
title’s should include a description of your page’s function but should not be 
more than about 160 characters long. 

The ‘Web Page Description’ allows you to add a description for each page. The 
description often appears when your page appears in a search engine results 
pages. The SEO For EverWeb video course has more details 
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Page Layout 
The Page Layout section (see 
Figure 8.2) is where you define 
the specifications of your page.  

First, choose from a Left Aligned 
page, a Centered page or a 
Responsive page.  

Specifying a value greater than 
zero in the ‘Top Margin’ field will 
create a space between your 
website and the highest point of 
the browser window.  

For example, if you add a shape 
to a page, and move it into the 
Header all the way to the top, you 
will see that there is a white space between the top of the page and where the 
page begins. This white space can be made something different, and we will 
get to that in just a moment.  

‘Content Width’ determines how wide your website will be. There is no set rule 
for how wide your website should be. However, you should consider that most 
users do not like to scroll horizontally and monitors maybe smaller than yours. 
A good value to use is 980 pixels, but that is not a hard limit. 

Note: Content Width is not used in Responsive website design so is 
unavailable if your page uses a Responsive Page Layout. 

The ‘Content Height’ determines the minimum length of the body of the web 
page. This rarely needs to be changed as the height will automatically adjust 
based on where you place objects (such as text, shapes or images) on your 
page. For example, dragging an object down on the page will increase its 
height. You will not see the value increase in this field, your page height will 
still be as long as you make it by way of the objects on the page. 

The ‘Header Height’ determines how high the Header will be. As with 'Content 
Height’, ‘Header Height’ also adjusts automatically based on what is in the 
Header. If you want the Header to be smaller decrease the value. 
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Figure 8.2: The Page Layout section on the Page Settings tab.
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Note: Header Height is not used in Responsive website design so is 
unavailable if your page uses a Responsive Page Layout.  

Finally, the ‘Footer Height’ determines the height of the Footer. As with the 
Header and Content Heights, the Footer adjusts automatically based on where 
objects are placed within it. Decrease the value if you want your Footer Height 
to be smaller 
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Page Background & Browser Background 
The Page Background appears behind your page content (see Figure 8.3). 
There are four options: 

• ‘None’ leaves the background as white 

• ‘Color Fill’ allows you to set the background as a solid color 

• ‘Gradient Fill’ allows you to use two colors that transition smoothly 

• ‘Image Fill’ allow you to place an image as the background. 

•

As mentioned earlier, selecting None sets the page background to solid white. 
Color Fill allows you to click on the color button which will prompt the color 
window to appear. You can make the background any color you want. 

 

Gradient Fill allows you to choose two 
different colors and have them blend 
together.  Each color can be chosen 
by clicking on the color button for 
each respective color. Once you have 
your two colors selected, you can 
modify the way you want the gradient 
to appear. For example, you can flip 
the order of two colors by clicking on 
the arrows.  

You can notice the page background 
changing when doing this. You can 
also choose the direction of the 
gradient. Toggling between the 
horizontal and vertical arrows will 
change the direction of the gradient 
from either horizontal or vertical. 
Alternatively, you can manually change the direction by adjusting the angle 
with the toggle, or by clicking on the up and down arrows. 
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Figure 8.3: The Page and Browser Background 
section on the Page Settings tab.
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If you want to have an image for your background, you will need to choose the 
image from your list of Assets, or from your hard drive by selecting Choose to 
open the Finder window. Once your image has been set as the page 
background, you can either have it set to Scale to Fit, Scale to Fill, Stretch, 
Original Size, or Tile. The option you choose will depend on the image you 
want as your page background. 

If you want, you can add a background shadow to your page by clicking the 
Shadow option. You can select the color for your shadow, and how big you 
want the shadow to be. The shadow option works with any type of page 
background. 

You can also add a browser background to your site. The browser background 
is the background styling behind your content area. For the browser 
background, there are two options. You can choose Color Fill which will allow 
you to choose a solid color for your browser background, similar to the page 
background. If you want this left as white, then you do not need to select 
anything. 

You can also choose to Image Fill the browser background. Again, you can 
select the image from your Assets list or choose to locate the image on your 
hard drive by pressing the ‘Choose’ button. When your browser background 
image has been set, you can leave it as Tiled or change it to Original Size. 
Again, the option you choose will be dependent on the image you have 
selected to use for your browser background.  
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Mobile Settings 
EverWeb allows you to create a 
mobile version of your website. If, 
however, you are creating a 
Responsive website, this is 
usually not necessary. 

All of EverWeb’s Fixed Width 
Theme Templates include a 
‘Mobile’ page design.  

To add a mobile page design to your website: 

1. Click on the ‘Add Page’ button 

2. Select the Fixed Width theme you want. Use the Filter dropdown menu 
in the Theme Template Chooser to view only Fixed Width Theme 
Templates.  

3. Select the ‘Mobile’ page style, then click ‘Select’. 

4. Your Mobile page is added to the Web Page List and is displayed in the 
Editor Window. 

You can also create your own mobile pages. To do this, set the Content Width 
of the page to 480 pixels in the Page Settings section of the Inspector Window. 
This pixel width fits well with iOS and most mobile devices. 

When your mobile page is ready, you must assign it to one of your regular 
pages. When you do this, EverWeb will automatically show the Mobile page 
when a visitor browses the page on a mobile device. 

To set up a mobile redirect: 

1. Select the page from the Web Page List that should redirect to a 
mobile page e.g. the Home, or default page.  

2. In the Page Settings tab in the Inspector window, scroll down to the 
Mobile Settings section (see Figure 8.4) 

3. In the Mobile Page drop down menu, select ‘One of My Pages’ 
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Figure 8.4: Mobile Settings on the Page Settings tab
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4. Select the mobile page you want to link to from the ‘Page’ drop down 
menu.  

5. If you have multiple pages for your mobile site, repeat these steps on 
those pages.  

When you publish your website, the mobile redirect will be enabled and you 
will be able to test this by visiting your website on your mobile device. 
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Header/Footer Code 
The ‘Header/Footer Code’ sections allow you to inject programming code, or 
script, in to your web page. The Header/Footer Code section is, therefore, of use 
to advanced EverWeb users. Typically you will not need to enter anything in to 
this section. 

Just like the rest of the settings on the Page Settings tab, any code or script 
entered into either fields will be applied to the respective page only, and not 
the entire site.  

Any codes placed in the Header Code section will be placed within the <head> 
tag in your HTML code.  

Any code placed in the Footer Code section will be placed right before the 
closing </body> tag. 
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Password Protection 
EverWeb lets you easily password protect the whole, or certain parts, of your 
website. 

For example, you could create a members only section on your website, or 
restrict access to certain individuals. 

Note: Password protection will only work on EverWeb’s Hosting platform. In addition, it can 
only be applied to Directories added to the Web Page list. 

To use Password Protection, use the ‘Add Directory’ button in the Toolbar. 

Click on the ‘Add’ button in the ‘Password Protection’ section. 

You can have unlimited passwords but all usernames must be unique. Also, 
you cannot use single quotes in the username or password field. 
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Redirects 
Redirects are a powerful but advanced feature. Say you have an existing 
website, such as an iWeb site that has been around for a while. You may have 
high search engine rankings for this site or you may have provided these links 
to other people. 

EverWeb lets you automatically redirect individual pages from your old site to 
your new site using a special type of redirect called a 301 redirect. These 
redirects have the benefit of maintaining your search engine rankings. 

To use this feature, enter the full URL of your old page. You can find the old 
URL by simply visiting your old site in your browser and copying and pasting 
the URL in the Path bar at the top of your browser window into this field. 

Remember, This feature is for individual pages. Each page on your old website 
should redirect to a unique page on your new EverWeb website. DO NOT just 
enter your main website’s URL for each page. Every redirect page in 
EverWeb should have a unique URL. 
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Shape Options 
All About Shapes & Images 
You can add a shape to your website by clicking on the Shapes 
button in the Toolbar, then selecting the shape you want to use 
(Figure 8.5).  

Shapes can be made larger or smaller, and moved around the 
Editor Window to your desired location. 

Use the Shapes tab in the Inspector Window to modify a shape 
(Figure 8.6). 

You can change the type of shape you are using by clicking in 
the drop down menu and selecting the shape you want.  

For each shape, there are three settings that you can make Fill 
modifications for: 

• Normal: How the shape will appear when no mouse 
cursor is over it 

• Mouse Over: How the shape will appear when the 
mouse cursor is hovering over it 

• Mouse Down: How the shape will appear when the shape has been 
clicked on. 

Tip: Any shape can have text on top of it. Just double click on the shape and begin typing. 
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For the shapes appearance, you have five options to choose from: 

• None: Makes the shape transparent - 
essentially what a text box is. 

• Color Fill: Allows your shape to have a 
color. Click on the color icon to change 
the color of the shape.  

• Gradient Fill: Allows the shape to be 
two different colors that transition 
smoothly. 

• Advanced Gradient Fill: Similar to the 
Gradient Fill but allows you to include 
more than two colors. 

• Image Fill: Select the image you want 
to fill the shape with. 

Full Width widgets such as the the FlexBox 
widget can also use the Shape Options color 
and image fill options to add a background 
color or image to the widget. 
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Stroke Options 
You can apply the following Stroke options to your shape: 

None 
No options are applied to the shape. 

Line 
Shapes can have a line stroke surrounding them. Select ‘Line’ from the Stroke 
drop down menu (see Figure 8.6).  

You can choose between a solid line, a dashed line and a dotted line.  

To set the color of the line using the color swatch. 

To set the thickness of the line by entering a number in the box, or by using 
the up/down arrows. 

 

Picture Frame: 
To add a picture frame to your shape: 

1. Select ‘Picture Frame’ from the 
Stroke drop down menu. 

2. Click on the picture frame 
thumbnail and select the frame you 
want to use (see Figure 8.7).  

3. Modify the thickness of the picture 
frame by adjusting the slider. 

www.everwebapp.com  of 73 207

Figure 8.7: Picture frames can be added to any 
image, shape, or text box.



EverWeb User Manual The Inspector Window

Shadow Options 
To add a Shadow to your shape click on the Shadow option (see Figure 8.6). 

Choose the shadow color you want by clicking on the color swatch 

The direction of the shadow can be altered by rotating the wheel icon or by 
entering a number from zero to 360 degrees in the box to the right of the 
wheel icon. 

Use Offset to set how far the shadow is away from the shape 

Use Blur to alter the sharpness of the object 

The Opacity is used to alter the opaqueness of the shape i.e. how see through 
or solid the shadow appears. 

Reflection Options 
You can also add a reflection to your shape, and specify how large you would 
like the reflection to be using the slider. 

Opacity Options 
To adjust the opacity of a shape, use the slider or the up/down arrows or enter  
the value in the box. 
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Animation Options 
You can animate objects to produce some amazing effects on your web page. 

1. Start by select the object you want to animate. Select multiple objects 
if you want to apply the same effect to many objects at the same time. 

2. In the Shape Options tab, tick the checkbox next to the word 
‘Animation’. The animation options are now displayed. 

3. A number of different animation styles are available in the first drop 
down list. Click on the animation effect you want to use. If you select 
‘Other’, a second list of animation styles will become available in the 
second drop down menu, 

4. Once you have selected an animation effect from the first drop down 
menu, use the second drop down menu for further styling options e.g. 
if you selected the ‘Flip’ animation effect from the first drop down 
menu, you have the styling options of ‘In Place’, ‘Horizontal’ or ‘Vertical’ 
available from the second drop down menu. 

5. If you selected ‘Other’ from the first drop down menu, you will see 
more animation effects listed in the second drop down list. These 
animation effects do not have any additional styling options. 

6. When you select your animation effect and styling options, you can see 
a preview of the effect in the preview window at the bottom of the 
‘Animation’ settings. 

7. Once you have chosen your animation effect use: 

• Duration: To specify how long the effect will last for (in seconds and 
milliseconds;) 

• Delay: To delay the start of the animation effect (in seconds and 
milliseconds) 

• Repeat: To replay the animation effect the number of times 
specified. 

8. Use the Preview button in the Toolbar to see the animation effect 
working on your page before publishing your website. 
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Metrics Inspector 
 

The Metrics Inspector (Figure 8.8) is where 
you can fine tune the size and position of 
objects as well as set other parameters 
relating to the selected object(s). 

Size 
This Size section of the Metrics Inspector is 
where you can adjust the pixel width and 
height of the selected object, set the object 
to scale as you resize it, set the object to the 
full width of the page and adjust Full Width 
object’s margins.  

Constrain Proportions 
When resizing an object you may want to 
keep its proportions whilst doing so. Tick the 
Constrain Proportions box if you want to the 
object width to scale proportionally as you 
adjust the object height and vice versa. 

Full Width 
If you want an object to dynamically resize its 
width as you resize the browser window tick 
the ‘Full Width’ option. When you use this 
option, the selected object expands to the 
size of your browser. 
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Remember that not all objects can be full width. For example, the Facebook 
Timeline Widget cannot be full width. For objects that cannot be full width the 
setting cannot be ticked. 

A full width navigation bar, or background object is a great example of when to 
use full width objects. 

Margin 
When an object is set as ‘Full Width’ you can add a left and right margin to it. 
This is useful if, for example, you are using a full width text box and do not want 
the text to appear right up against the left or right margins of the page. 

Maximum Width 
By default, full width objects will display to the full width of the page. In some 
instances this is not useful as objects may appear too spaced apart from each 
other or you may not want an object to expand to the entire length of a wide 
screen.  

Use the ‘Maximum Width’ field to set a maximum limit to the width of the full 
width object. If you leave the value at zero, the full width object will always 
scale to the full page width. 

Position 
Use the X and Y position fields to fine tune the position of the selected object. 
Modify the X (Horizontal) and Y (Vertical) values in the Position section as 
required. The object will move to the specified coordinates.  

You can also click on the up and down arrows of the X and Y position fields to 
change the Position values. 
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Allow Free Dragging 
You’ll notice when dragging objects around the EverWeb design canvas that 
you may be prevented from dragging the objects out of the Header, main 
body area or Footer.  

These three sections help you organize your web page design so that anything 
added in the Header section can actually move the content in the main body 
area and the Footer area down so that you don’t always have to adjust your 
design every time you want to change your header. 

The same applies to the main body area, where objects moved downwards 
here will adjust the top position of the objects in the footer. 

The ‘Allow free dragging' option tells a shape to ignore these boundaries and 
lets you drag it anywhere on the design canvas. The position of a ‘free 
dragging’ object does not effect any of the objects in any other section. 

Fixed Positioned Objects 
EverWeb lets you have fixed positioned objects so that as you scroll your page, 
the object’s position is always the same. This lets you add features such as a 
navigation menu that always stays fixed in place as the page is scrolled. 

Use the ‘Fixed Position’ checkbox and the ‘Relative to browser left’ option 
underneath it to fix the position of an object. 

The ‘Fixed position’ option displays the object exactly where you placed it on 
the Editor Window as your page is scrolled vertically or horizontally. However, 
for a ‘Centered Aligned’ page layout (which is the default Page Layout in 
EverWeb) the object will be anchored to the left margin of the page. This 
means the object’s left position will move as you resize your browser window. 
This creates an effect of a centered, fixed positioned object. 

Select the ‘Relative to browser left’ option so that the object will not adjust its 
left position as you resize your browser. Instead, the object stays in the exact 
same position, no matter if you scroll or resize your browser. 

‘Relative to browser left’ is only relevant when using the ‘Centered Aligned’ 
page under Inspector->Page Settings->Page Layout section. 
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Always On Top 
When you add objects to the Editor Window, they can appear stacked on top 
of each other. Usually you can use the Arrange menu’s Bring Forward/Send 
Backwards or Bring to Front/Send to Back options to layer objects as you wish 
on top of each other.  

In some instances, e.g. with Master Page objects, you may need to force 
objects to the top of the stack so they are never obscured. Check the ‘Always 
On Top’ box or use the Arrange-> Always On Top menu option to force an 
object to the top of the stack so that it is always visible. 

Rotation 
Use the ‘Rotation’ wheel to rotate the selected object from 0 through 360 
degrees or use the Flip Horizontal or Flip Vertical buttons to flip the object 
vertically or horizontally. 

Responsive 
Show on Device 
You can choose on which devices objects are to be displayed upon by using 
the Responsive options. Select the object you want and then check or uncheck 
the ‘Show on…’ ‘Mobile,’, ‘Tablet’, Desktop’ and ‘Wide Desktop’ options as 
desired.  

As you change the the width of the Editor Window, you may notice that 
objects you unchecked disappear as they become hidden. You can view these 
hidden objects by using the Window-> Show hidden Objects menu. Objects 
that are hidden will be displayed as placeholders boxes with a grey 
background with an ‘X’ cross through the object. 
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Hidden objects can also be selected by secondary clicking on the page. From 
the menu that appears scroll to the ‘hidden Objects’ menu item and select the 
object you want.  

Breakpoints 
You can set how wide the Editor Window canvas is for each device type: 
mobile, tablet, desktop and wide desktop. These values are used in responsive 
web pages and are known as ‘breakpoints’. A The responsive page will respond 
to appropriately at each breakpoint so the the page always renders correctly 
on each device type. 

Use the ‘Breakpoints’ button to change the value of the breakpoints. To reset 
the values back to their original defaults click on the ‘Set Default’ button. 
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Text Inspector 
 

To add text to your website, simply click on the Text Box 
button, which is located in the Toolbar. A text box will appear 
on the editor, and you can edit it by double clicking inside the 
text box. Alternatively, if you have text on the site already, 
which might be there from a template, you can also double 
click inside the box to edit the text. 

 

There are two ways to edit your text. If you want to edit some 
of the text in the text box, highlight the text that you want to 
edit. If you want to edit all of the text in the text box, just select 
the text box on its own. If you want to change the font of your 
text click on the Fonts button, and then select the font you 
want to use. You, can also change the font size by adjusting 
the size using the scroll, or by typing in the font size.  

You can also change the color of the text by clicking on the text color icon 
which will bring up the Colors window. 

You can also change the text color by using the Colors shortcut located on the 
Toolbar. You can also click on the Text tab in the Inspector window, and change 
the color by clicking on the color icon which will also bring up the Colors 
window (see Figure 8.9). 
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You can also align the text left, center or to the right. You can align the text to 
be at the top of the text box, the middle of the text box, or at the bottom of the 
text box. 

If you want your text to have a colored background, you can select the 
Background Fill option, and then select the color image to change the color of 
the background.  

You can alter the space between each character by adjusting the character 
spacing. To alter line spacing adjust the line height of the text. You can also set 
the before and after paragraph spacing. For example, if you want there to be a 
larger gap between two paragraphs, you can either click after the paragraph 
and then increase the After Paragraph value, or you can click before the 
paragraph and then increase the Before Paragraph value. 

You can also modify the Inset Margin value for the text box, so that you can 
control where in the text box your text will be placed. The Inset Margin will 
apply padding around your text and the enclosing text box. 
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Modifying Fonts & Styles 
EverWeb makes it easy to work with different fonts and styles. To change the 
font, size, and styling of text you can use the ‘Fonts’ button in the Toolbar at the 
top of the main window. 

Important 
Working with fonts online can get tricky because not all users will have the font you want to 
use installed on their computer. When someone visits your website on their computer and 
they do not have the font you used installed, their web browser will substitute the font for an 
alternative, closely matching font. 

This can cause formatting issues for some users, especially if they are using a 
mobile device or an operating system that is different than yours. 

The font issue is further complicated due to the fact that fonts can have 
various licensing terms that restrict you from using them on your website 
without purchasing the appropriate license or checking with the creator of the 
font. Even if you use your font on your computer, you may not be licensed to 
use it on your website. 

There are four ways around the problem with fonts that each have benefits 
and drawbacks; 

1. Use only web safe fonts 

2. Use Google Fonts 

3. Convert your text to an image 

4. Use a custom font 

The best and most recommended solutions include; using the Web Safe fonts 
from the Fonts Panel or using Google Fonts. EverWeb makes working with 
Google Fonts very easy and it is explained in more detail in the next section of 
this manual. 

The other solution is to use the option labelled ‘Export Text as Image’ under 
Inspector->Text Settings. For this to work select the TextBox you want to 

www.everwebapp.com  of 83 207



EverWeb User Manual The Inspector Window

convert to an image and check the ‘Export Text as Image’ option in the 
Inspector. 

You must keep in mind that this option will prevent user’s from being able to 
copy and paste the text and will prevent search engines from being able to 
‘read’ the text that has been converted to an image. It is not recommended for 
text other then logos or critical text that needs to be displayed exactly the 
same in all browsers and all devices. 

The fourth option can get technical and also requires that you obtain the 
proper license for the font you want to use. You can actually include the font 
file in your website by following this third party tutorial on how to include 
custom fonts on your EverWeb website. 

Remember, custom fonts, even if they are included on your computer for your 
use, may not be allowed to be used on your website. Every font has different 
licensing restrictions so check with the creator of the Font if you are allowed to 
use your intended font on your website. You can usually find the creator of the 
font by Googling the font name in your web browser. 
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Using Google Fonts With EverWeb 
Google Fonts are a free and great way to include custom fonts on your 
website. EverWeb makes it really easy to work with Google Fonts. 

Google provides over 900 free fonts that you can use on your website and that 
are guaranteed to work across virtually all browsers and devices. It is your best 
option to provide unique fonts for your visitors. 

EverWeb makes it very easy to use Google Fonts on your website. All you have 
to do is follow these steps; 

1. Visit the Google Fonts web site and find the font you want to use 

2. Once you have found the font (or fonts) you want to use, click the ‘Add 
to Collection’ button next to each font 

3. Once you have collected all the fonts you want to use, click the down 
arrow in the top right corner to download the fonts to your computer 

4. The fonts will be downloaded to your computer and you can simply 
double click them to install them. You may need to close and re-open 
the Fonts panel in EverWeb (or even quit and relaunch EverWeb in 
some cases) to see them in the Fonts Panel 

5. Then just use the fonts as you normally would and EverWeb takes care 
of the rest when you publish your website 

A detailed tutorial on using Google Fonts in EverWeb can be found here. This is 
a third party tutorial with detailed instructions and screenshots on using 
Google Fonts on your EverWeb website. 

www.everwebapp.com  of 85 207



EverWeb User Manual The Inspector Window

Hyperlinks Inspector 

Linking any object in EverWeb is very easy to do. Simply select the object, and 
click on the Hyperlink tab in the Inspector window (Figure 8.10).  

Check the box to ‘Enable as Hyperlink’. You will then be able to select where 
you want to link the object to. 

You can choose to link one of your website pages by selecting ‘One of My 
Pages’, and then choosing the page that you want to link to from the second 
drop down menu. 
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You can choose to link to an external page by typing in the URL you would like 
to link to. If you want the link to open in a new window when the user clicks on 
the link, select the option to Open in New Window. 

You can choose to link to a file, which you can choose from on your hard drive. 

You can also choose to link to an email message by entering the destination 
email address and subject. When a user clicks on the link, their default email 
client will open with the email address and subject already plugged in.  

If you link text, you can edit the Hyperlink Formatting for that text. You can 
change the color for how the text will appear normally, when the user hovers 
their cursor over the link, when the user has already visited the link, and how 
the link appears if it has been disabled. Each of these options can be 
underlined by clicking on the underlined ‘U’. 
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Scroll Position 

EverWeb’s Scroll Position feature lets you easily set up ‘anchors’ on your pages 
that can be hyperlinked to a piece of text, shape or any other object that can 
be hyperlinked to. In this way you can hyperlink to any position, on any page, 
within your website! 

Note: Scroll Position is not supported for Responsive website designs. 

For example, you may want a button at the top of the page that when clicked 
upon takes the visitor to a specific paragraph further down the page, instead 
of having the visitor manually scroll down to the paragraph (see Figure 8.11). 

1. Create a button by adding a rectangle shape from the Shapes button 
in the Toolbar and position it at the top of the page. Click inside the 
button and add the button text you want. Use the Text Inspector 
Alignment options to position the text in the center of the button. 
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2. Once you have set up your button, click on the Scroll Position button in 
the Toolbar, or use the Insert -> Scroll Position menu option. 

3. A light blue horizontal line appears across the width of the page near 
the the top of the body section of the page. The blue line acts as an 
‘anchor’. 

4. Click and drag the blue line ‘anchor’ to where you want it on the page 
e.g. the top of a paragraph further down the page. Notice that the line 
does not have any selection handles and is dark blue when not 
selected. 

5. Once you have placed the Scroll Position anchor, you will want to link it 
the button you added earlier. Click on the text in the button to select it. 

6. Go to the Hyperlinks Inspector and tick the checkbox ‘Enable 
Hyperlink’. 

7. Make the ‘Link To’ option ‘One of My Pages’. In the ‘Page’ section select 
the current page as this is where your Scroll Position anchor is located. 

8. The ‘Position’ field shows ‘Top of Page’. Click in the drop down and you 
will see another option starting with ‘scrollposition’ followed by a ‘-‘ and 
a number e.g. ‘scrollposition-857’ means that the scroll position anchor 
you added is 857 pixels down from the top of the page. See Figure 8.13. 

9. Select the scroll position. The button and the scroll position are now 
linked. 

10. From the Toolbar select Preview to test that the button and scroll 
position are set up correctly before publishing. Click on the hyperlinked 
button. You should automatically scroll down to the paragraph where 
you set the scroll position at. 
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Nofollow Link 
The Additional Settings section has a ‘Nofollow link’ option. When you link to 
page you are implicitly telling your visitors. or search engines, that this is a 
recommended page by you. Sometimes this may not always be the case e.g. 
linking to a competitor website or page. 

For your actual visitors, the context of your link could indicate that this isn’t 
actually something you recommend. However, search engines will still believe 
you are vouching for this linked page.  

By selecting ‘Nofollow link’ you are essentially telling search engines that you 
don't actually vouch for this page and that you don’t want to pass your 
website’s reputation to this page.  

This is important because if you link to a page with a bad reputation according 
to search engines, it can negatively affect your page’s reputation and in turn 
lower your search engine rankings. 

Select this option when linking to a page you don’t particularly trust or 
recommend. 
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Linking to PDF files or Other Files for 
Download 
You can easily link to any file, including PDF files, for website visitors to 
download from the Hyperlinks tab. 

From the ‘Link To:’ drop down menu select ‘A File’. Then from the ‘Choose…’ 
button select the the file from your computer that you would like user’s to 
download. This can be anything including; PDF files, word documents, images 
etc. 

The linked file will appear in the ‘External Files’ section of the ‘Assets List’. The 
file is copied into your Project’s folder and then to your server when publishing 
your website.  

Linked files are not downloaded from your actual computer, they are 
downloaded from the copy that EverWeb has published to your website. 
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Widget Settings 
The last tab of the Inspector Window is the Widget Settings tab. The settings 
that this tab contains will depend on the object that is currently selected. 

Widget Settings can apply to objects such as widgets, some shape objects 
such as the star shape and blog posts. 
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9The Assets Tab

The Assets Tab is where image and other media files, 
such as audio, video and PDF files, are listed and 
available for use in your website project.

The Assets List

Asset List Organization

The Media Browser

Free Stock Photos
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The Assets Tab 
The Assets List 

Images files, and other media such as audio, 
video and PDF files, that are added to your 
website appear as ‘assets’ in the Assets List of 
the Assets Tab (Figure 9.1).  

You can add any type. of image file to the 
Assets List. First click on the Assets tab if it is 
not already selected, then drag and drop the 
image you want added from its file location in 
to the Assets List. 

There are many ways to add images to your 
website. For example, you can drag the image 
from your desktop onto the Editor Window. 
You can also drag the image from the macOS 
Finder window on to the Editor Window. You 
can also use the Insert-> Choose menu option 
and select the image you want to add.  

You can also add an image by adding a 
TextBox or shape: 

1. Add a TextBox or shape to your page 
(any shape will do). 

2. Click on the Shape Options tabs in the Inspector Window 

3. Select ‘Image Fill’ from the drop down menu.  

4. Click on the ‘Choose…’ button. A list of image files will appear. If the 
image file is not yet in the Project file, select the ‘Choose…’ option 
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which will open the Finder window so that you can select the image 
that you want to use.  

Note that the same method can be applied for adding an image to the Page 
and/or Browser Background. 

Any image in the Assets List can be used on any page of your website just by 
dragging it from the Assets list and dropping it on the Editor Window. The 
same image can be used multiple times throughout your site. You do not 
need to add the image again to your website every time you want to use it. 
When you add an image to a page, it remains in the Assets List so is available 
for use on any page in your website. 

Assets can be organized conveniently into folders making it quicker and easier 
to group, and find, the images and assets you want to use. 

Image files can be previewed using the ‘eye’ icon, where you can preview, 
share and even edit the image without having to leave EverWeb to do so. 

Assets List Organization 

Image files and other media assets, such as audio, video, PDF files etc., can be 
conveniently organised in to folders. Organising assets is especially useful 
when you have a website with a large number of assets., or if you want to 
organize your assets based on the pages you have created in your website. 

Use the Asset List Organizer (see Figure 9.2), located at the top of the Assets 
List, to search for assets, add and delete Assets List folders and to access Assets 
List related options using the Settings Cog  
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In addition to the search box, the Assets List Organizer has thee buttons: 

• The ‘+’ button allows you to add a new folder to the Assets List 

• The ‘-‘ button allows you to delete a folder, or one or more assets, from the 
Assets List 

• The Settings Cog displays a menu of actions specific to the Assets List: 

• Sorting the Assets List contents 

• Finding unused assets 

• Displaying detailed information about individual assets. 

Creating an Assets List Folder 
To create a new Assets List folder: 

1. Click on the Assets tab in the Inspector Window if the Assets List is not 
currently displayed. 

2. To create a folder in the ‘Images’ section of the Assets List, either select the 
title ‘Images’, an existing folder in the Images section, or one of the image 
assets in the Images list. 

3. To create a folder in the ‘External Files’ section of the Assets List, either 
select the title ‘External Files’, an existing folder in the the External Files 
section, or one of the files in the External Files list.  

4. Click on the ‘+’ button to create a new folder. 

5. Enter the name of the folder. You can use letters, numbers and a variety of 
special characters. If you enter characters that are not allowed, these will be 
ignored. Click on the ‘OK’ button to finish. The folder will be created and 
located. 

6. The folder will be created at the top of the Assets List unless you have 
created a subfolder. In this case, the new folder will be inside the patent 
folder. To create a subfolder highlight a folder in the Assets List, then click 
on the ‘+’ button. Name the folder as in the above step. 
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7. You can also create a new folder by secondary clicking in the Images or 
External Files section. A menu will appear. Click on the 'Add Folder' option 
and continue with step 5 above. 

Renaming a Folder 
To rename a folder, double click on its name. Edit the name and press 'Enter' to 
finish. 

Moving Assets List Subfolders 
You can move subfolders out of their parent folder, or into other folders, just by 
dragging and dropping the folder to its new location. 

Adding and Moving Assets 
Assets can be added to, moved, and removed from, a folder by drag and 
dropping the asset file to its new location. You can also drag and drop multiple 
asset files at one time. 

To add an asset in to a folder, drag it from its current location in the Assets List 
and drop it on top of the folder. The file will be added to the folder. If you 
already have files within the folder and the folder itself is open, you can drag 
and drop the file on top of the files that are within the folder. 

To move an asset from a folder, drag it to the left of the triangle symbol. The 
file will be relocated one level up. To move a file back in to the main Asset List, 
make sure that you move it left of the left most triangle symbol. 

To move a group of assets that are listed one after each other in the Assets List, 
click on the first asset in the list, then Shift+Click on the last asset you want to 
move in the list. Drag and drop the highlighted assets to their new location. 

To move files that are in different locations in the Assets List, click on the first 
asset you want to move, then press Command+Click on each of the other 
assets in the list that you want to move. When you have finished selecting the 
assets, drag and drop the highlighted assets in to the folder where want you 
them.  
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Deleting an Assets List Folder 
You can delete a folder from the Assets List in a number of ways. First highlight 
the folder you want to delete in the Assets List then either: 

• Click on the ‘-‘ button in the Assets List Organizer.  

• Press the backspace key or 

• Secondary click on the folder and select the ‘Delete Folder’ option.  

In all cases, a dialog box will be appear with options to ‘Delete Folders & 
Contents’, ‘Delete Folders Only’ or ‘Cancel’. Select the option of your choice 
(See Figure 9.3). 

If you select ‘Delete Folders Only’, any assets the folder contains will be moved 
to the next folder level up in the Assets List.  

Displaying Assets List Folders 
When you add a new folder to the Assets List, it will be empty and the folder 
will be displayed as closed, which is shown by the triangle symbol pointing to 
the right, towards the folder name. You can toggle the folder open or closed at 
any time by clicking on the triangle. When the folder is open (see Figure 9.1), 
the triangle points downwards and the folder contents are displayed. 
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Previewing Image Files 
Clicking on EverWeb’s Assets List Preview ‘eye’ icon allows you to: 

1. Preview the selected image file. 

2. Access Apple’s Preview app where you can edit the image directly without 
having to leave EverWeb. 

3. Share the image file using the Share Sheet icon. 

4. Display the image preview at full screen or at a size you want by dragging 
the corners of the Asset Preview window. 

The Assets List Settings Cog 
The Assets List Settings Cog allows you to 

1. Set the sort order of the Assets List 

2. Display detailed file information about image file assets such as file size 
and image dimensions 

3. Locate any any assets that are not used in your website project so that you 
can delete unwanted assets if desired. 
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The Media Browser 

In addition to the Assets List, the Media Browser in EverWeb’s 
Toolbar can be used to access images and other media.  

If you click on the ‘Media’ button, you will see a sub menu 
displayed with a choice of two options: 

• The Media Browser(see Figure 9.4) 

• The free Stock Photos library. 

You can add images to your website from media 
locations such as Apple Photos. You can drag and 
drop additional folders onto the Media Browser so 
you can access images from any accessible folder 
location.  

Whenever you want to add an image from the 
Media Browser simply drag and drop the image 
either on the Editor Window or in to the Assets List.  
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Stock Photos 
EverWeb allows you to easily access over half a million free to use stock photos 
that can be included in your website. To add a Stock Photo to your page: 

1. Go to  the Window-> Stock Photos… menu option or click on the Media 
button in the Toolbar and select ‘Free Stock Photos’.  

2. The Image Search window will open with a search bar at the top. 

3. Enter the word(s) that you are searching for e.g. ‘Cat’ and press Enter to 
perform the search.  

4. Images that match your search criteria will be displayed below the 
search bar. If no results are found, the Image Search window displays 
the text ‘No Results Found’. 

5. Drag and drop the image that you want to use onto the Editor 
Window.  

6. To add a Stock Photo in a blog post, first make sure the blog post you 
want is selected, then drag and drop the image from the Image 
Search box onto the Blog Post Editor Window or Blog Post Preview 
Window. 

7. To add a Stock Photo to the Assets List, first select the Assets tab, then 
drag and drop the Image you want from the Image Search box into 
the Assets List. The saved image can then be used later. 

8. Images in the Assets List are named after the search criteria. 

You can keep the Stock Photos search window open whilst working on your 
website. If you want to bring the Stock Photos search window to the front, just 
use the Window-> Image Search option. 

When you quit EverWeb, the Image Search window also closes. When you 
enter EverWeb the next time, you will need to reopen the Stock Photos Image 
Search window again to use it. 
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10The Widgets Tab

Widgets are like mini-apps that allow you to easily add 
extra features and functionality to your website without 
having to code.

The Widgets Tab

Widget Organization

EverWeb’s Default Widgets
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The Widgets Tab 

EverWeb includes a number of built in ‘widgets’. 
A widget is like a mini app that allows you to 
easily add extra features you may want to your 
website (see Figure 10.1). For example, use the 
Navigation Menu widget to create a simple, 
dropdown or responsive menu system for your 
website. You can use the PayPal widget for E-
Commerce, the Image Slider and Image Gallery 
widgets to display images in a number of 
different ways and so on. 

Adding a widget to your web page is easy: 

1. Select the page on which you want to 
add the widget. 

2. Next select the Widgets tab in the 
Inspector Window on the right hand 
side. 

3. Find the widget you want to use and 
drag and drop it on to the Editor 
Window. 

4. Size and position the widget as required. 

5. Use the Widget Settings in the Inspector 
Window to customize the widget, or 
setup widget specific defaults, as you 
want. 
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Widget Organization 
EverWeb includes a number of built in widgets. Additional widgets are 
available, either free or to purchase, from third party widget providers. You can 
easily add widgets to the Widgets tab as described below. 

If you have added third party widgets into EverWeb, you may want to organize 
the Widgets Tab so that they are easily accessible. 

 

Widget Category Settings 
Directly beneath the Widgets Tab, are the Widget Category Settings (Figure 
10.2) which includes the Category List drop down menu, the Remove Category 
button, the Category Settings button and the Add Category button. These 
features allow you to organize and manage your widgets. 

www.everwebapp.com  of 104 207

Figure 10.2: The Widget CategorySettings



EverWeb User Manual Widgets

Widget Category List 

The Widget Category List dropdown (Figure 10.3) contains two predefined 
widget categories that cannot be deleted. The Widget Category List includes 
any categories you have created under the predefined categories.  

Click on the Category List dropdown to select the category you want displayed. 

• The ‘All’ Category 
The ‘All’ category displays all of the widgets that have been installed on 
your computer. You can add, move and delete third party widgets in to 
this category. You cannot remove EverWeb’s set of default widgets. 

• The ‘Default’ Category 
The ‘Default’ category lists only EverWeb’s preinstalled widgets. You 
cannot add, move or delete these widgets from this category. If you 
have no third party widgets installed on your computer, the ‘All’ and 
‘Default’ categories will look the same. 

• User Created Categories 
If you have created your own categories, these are listed below the ‘All; 
and ‘Default’ categories. You can rename a user created category, add 
third party widgets into the category, remove widgets from the 
category and delete the category itself using the controls immediately 
beneath the Widgets tab (see Figure 10.2). 
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Adding Widgets to the Widgets Tab 
To add third party widgets to the Widgets tab, just drag and drop the widget(s) 
you have downloaded on to the Widgets tab.  

If the widgets you want to add are in a folder, you can drag and drop the folder 
itself on to the widget list. When you do this, EverWeb will create a new 
category with the same name as the folder. All of the widgets in the folder will 
be placed within the newly created category. 

Creating a New Widget Category 
To create a new Widget Category: 

1. Click on the Add Category ‘+’ button in the Widget Category Settings 

2. A dropdown will appear asking you to enter the name of the Widget 
Category you want to create (Figure 10.4).  

3. Enter the name you want then click the ‘OK’ button to finish. 

4. If you try to create a category that already exists, EverWeb will ask you 
to enter a unique category name. 
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Once you have created a new category, it is added to the Category List. If you 
click on the category you have just created you will see that it contains no 
widgets. 

Renaming a Widget Category 
 

To rename a Widget Category: 

1. Select the category you want to rename from the Widget Category List 

2. Next, click on the Category Settings cog. 

3. A drop down will appear (see Figure 10.5) where you enter the new 
name for the Widget category.  

4. Click the ‘OK’ button when finished.  
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Adding Widgets in to a Category 
There are a number of ways to add widgets to a Category: 

1. Move the widget from one category to another.  

1. Secondary click on the widget you want to move.  

2. The ‘Move To’ submenu will appear. Mouse over the ‘Move To’ menu 
option so that the Category List appears.  

3. Click on the Category you want to move the widget to.. The Widget will 
be moved to the category you have selected.  

4. Note that if you are performing this operation from the ‘All’ Category, 
the widget will still appear in the List as well as in the Category you 
have moved the widget to. Remember that widgets cannot be moved 
from the Default Category List. 

2. Drag and drop third party widgets directly in to the Widgets tab. 

1. First select the category that you want the widget to be included in. 

2. Drag and drop the widget into the Category. Remember that any 
widgets added  will always appear in the ‘All’ Category List. 

3. Drag and drop third party widgets in a folder directly in to the Widgets tab. 

1. The Folder name is used to create a new Widget Category, therefore, 
name the folder as the name of the Category that you want to create. 

2. Drag and drop the folder containing the widgets into the Widgets 
List..A new category will automatically be created that contains the 
widgets in the folder. 
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Deleting Widgets 
To delete a widget from a category, secondary click on the widget and select 
‘Delete’ from the menu. When you do this, you will be asked to confirm the 
deletion. The dialog box also states that when you delete a widget it will be 
placed in the Trashcan. 

If you delete a widget by mistake, go to the Trashcan and drag and drop the 
widget back on to the Widgets list. 

Only third party widgets can be deleted. It is recommended that you back up 
any widgets free or purchased third party widgets in case you need to restore 
them for any reason at a later date. 

Deleting a Widget Category 

To delete a Widget Category,  

1. Click on the Remove Category ‘-‘ button. 

2. A dropdown will appear asking you to confirm your actions (Figure 
10.6). There are three choices: 

• Select ‘Delete Widgets’ to delete the Widget category and the 
widgets in the category from EverWeb. If you delete the widgets 
by mistake, open the Trashcan on your computer and drag and 
drop the widgets back in to the Widgets list. 
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• Select Cancel to stop the category deletion 

• Select ‘Keep Widgets’ to move the widgets from the category that 
is being deleted to another category. 
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EverWeb Default Widgets 

EverWeb includes built in ‘default’ widgets. Each widget is described below in 
detail in the order in which it appears in. the Widgets tab. 

Some of the widgets listed are categorized to help you identify when the 
widget can be used in Fixed Width, Responsive or both page layout styles. 

[Full Width Capable] 

Most widgets, such as the YouTube Video and Google Maps widgets, can be 
used as Full Width objects in Fixed Width and Responsive page layouts. Use 
the Full Width checkbox in the Metrics Inspector to toggle Full Width 
capability on or off as required.  

Full Width capable widgets can be used as Section objects in their own right in 
a responsive page layout when ‘Full Width’. If the widget is not to be used at 
Full Width in a responsive page layout, it must be embedded in to a 
Responsive Row widget in order to work correctly. 

[Responsive] 

Some EverWeb’s Widgets, such as the Responsive Row and FlexBox widgets, 
are designed specifically for use only in a Responsive Page Layout. Whilst 
these ‘Responsive’ widgets can, in theory, be used in a Fixed Width page 
layout, it is not recommended or supported. 

Uncategorized Widgets 

Where a widget has not been categorized as either ‘Full Width Capable’ or 
‘ResponsiveOnly’, the widget is not Full Width capable e.g. the PayPal widget.  

In this instance the widget can be drag and dropped anywhere on your page 
when using a Fixed Width Page Layout. 

When using a Responsive Page Layout, the widget must be embedded in a 
Responsive Row widget in order to work correctly. 
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Navigation Menu Widget [Full Width Capable] 
EverWeb’s built-in navigation menu makes it easy to add a navigation menu 
that links to some, or all, of the pages of your website. Simply drag and drop 
the Navigation Menu widget onto the Editor Window. A menu with links to 
some, or all of the pages on your site will appear. 

Navigation menus can either be simple, dropdown or responsive. 

You can modify your navigation menu settings using the Widget Settings tab 
in the Inspector. On this tab, you can change the navigation menu’s 
alignment, padding, spacing, and minimum width.  

If you have created a dropdown navigation menu you can change the 
background color and the mouse over color for the submenu. 

If you have set the navigation menu to be responsive, you can set when the 
navigation changes from a menubar to a hamburger style icon and the styling 
of the hamburger icon. 

To change the font type and font size of the text, click on the Fonts button in 
the Toolbar and make your changes. If you are using a responsive navigation 
menu, use the options in the Hamburger Button section of the Widget 
Settings instead. 

To change the text color of the navigation menu, and the Rollover and Visited 
colors, use the Hyperlinks tab. In the Hyperlink Formatting section click on the 
color swatch next to the option you want to change (e.g. ‘Rollover’) and select 
the color you want to use. You can also select if link to be underlined. 

Tip: If you do not want a page included in the navigation menu, go to the Inspector Window. 
Click on Page Settings tab. In the Page Details section, uncheck the ‘Include in navigation 
menu’ option. 

RSS Feed Widget 
The RSS Feed widget allows you to place a third-party website’s RSS feed on 
your website. This allows you to provide your website visitors with updated 
content, without having to do anything.  

To use the RSS Feed widget, simply drag and drop the widget onto the editor. 
On the Widget Settings tab, paste or type in the URL for the feed you want 
displayed on your website. 
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You can adjust the widget on your site so that it is bigger, smaller, wider, or 
more narrow. You can also play around with the rest of the settings on the 
Widget Settings tab until you are satisfied with the way the RSS feed is 
displayed on your website. 

Image Gallery Widget 
Instantly create image galleries to show off your photography, art, family or 
more. EverWeb automatically creates professional image galleries for your 
website with the Image Gallery widget. 

Responsive Row Widget [Responsive] 
The Responsive Row Widget is only used in a Responsive Page Layout. The 
widget acts as a container that allows you to add text, shapes, images, media 
and widgets to a responsive web page.  

The Responsive Row Widget is useful for adding any number of elements that 
should be adjusted vertically as the browser window is resized to a smaller 
width. Objects will align horizontally or vertically so they can fit within the 
browser size dimensions without requiring the website visitor to scroll 
horizontally. 

The goal of the Responsive Row Widget is to allow any object - text, images, 
widgets etc… - to be added to a responsive website without having to actually 
be responsive themselves. As well, to allow multiple objects to appear 
horizontally on your webpage if the browser can it them. Otherwise they are 
displayed vertically. 

For more information please refer to the ‘Responsive Websites in EverWeb' 
chapter. 
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Audio Widget [Full Width Capable] 
The Audio widget supports the HTML5 Audio Player so you can add MP3 files 
to your web page. You can set the default playback volume, and there are also 
options for looping, autoplay on page load and muting the audio. 

Contact Form Widget [Full Width Capable] 
To add a contact form to your website, drag and drop the Contact Form widget 
onto the Editor Window. In the Widget Settings, enter your email address in 
the ‘Email Address’ field. This is very important as this is the email address that 
will receive any of the messages submitted using this contact form. You can 
edit the fields on the Contact Form to add different fields other than the ones 
on your form. For example, if you wanted users to submit their full names, you 
could change the ‘Name’ field from “Name:” to “Full Name:” This will display 
Full Name and users using your form will know to enter their full names. 

Contact Form Advanced Widget [Full Width Capable] 
Contact Form Advanced lets you create highly customized forms. You can add 
drop down menus lists, tick box lists, radio buttons and much more to your 
form. The widget lets you add extra fields e.g. you could create a ‘Special 
Greetings’ field and pre-fill it with default text e.g. ‘Add your special greeting 
here!’ to help your visitors complete the form. Contact Form Advanced is 
perfect for sales orders, customer surveys or any time when you need a flexible, 
highly customisable form solution. 

Contact Forms Enhanced Addon is the perfect addon to Contact Form 
Advanced widget for managing and reporting your contact form submissions. 
See the Contact Forms Enhanced Addon chapter for more details. 

FaceBook Like Widget 
If you have a Facebook page, you can place a Facebook Like button on your 
website. Just drag and drop the Facebook Like widget onto the Editor. On the 
Widget Settings tab, enter your Facebook Page URL. 
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FaceBook Page Timeline Widget 
If you have a Facebook page, you can display it on your web page using this 
widget. Drag and drop the widget onto the Editor and enter your Facebook 
Page web address. Use the Widget Settings tab to customize the look of the 
widget. 

FlexBox Widget [Responsive] 
The FlexBox widget allows you to combine styled text, images, video and 
buttons in the combinations of your choice for a responsive layout the adjusts 
its layout depending on the screen size.  

The widget is highly customisable including mouse overlay effects and object 
wrapping options for incredible design flexibility. 

The FlexBox widget is extremely useful in a Responsive website as it adjusts its 
contents to the size of the browser window. 

Google Maps Widget [Full Width Capable] 
To add a map to your website, drag and drop the Google Maps widget onto 
the editor. On the Widget Settings tab, enter the address for the location you 
want the map to display. When you are done, click the Apply button. You can 
increase, or decrease the size of the map to suit your needs. 

Google+ Widget 
Google+ has now been discontinued. The Google+ widget is included only for 
legacy purposes. 

Heading Tags Widget [Full Width Capable] 
Easily add HTML Heading Tags to your EverWeb pages using the Heading Tags 
Widget. You can style the Heading Tag to match your web page by just using 
the Fonts Panel and the Color Picker. 
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HTML Snippet Widget [Full Width Capable] 
The HTML Snippet is the most powerful widget as it allows users to add almost 
anything to their website. Anytime you want to embed, or add an item to your 
website, if you are given an HTML script for that item, you will paste it in the 
HTML Snippet widget. 

Tip: The HTML Snippet widget lets you add any type of code to your website which makes it 
both powerful and having the potential to cause publishing problems if your enter incorrect 
HTML Code. Make sure you know what the code is doing when using the HTML Widget 

Image Slider Widget [Full Width Capable] 
The Image Slider widget creates a slideshow of images that can be set to 
transition from one image to the next. Drag the image slider onto your 
webpage and then add images using the ‘Choose…' button. 

Live Photo Widget 
Add Live Photos from your iPhone to your website. From the Photos app select 
the Live Photo you want, then go to File-> Export Unmodified Original Photo. 
Add the resulting .JPG and .MOV files to the Live Photo widget!  

PayPal e-Commerce Widget 
The PayPal e-commerce widget lets you add either PayPalPayPal Buy Now 
buttons or a fully featured Shopping Cart. You can even add a ‘Donate’ button. 
The PayPal widget is highly customizable so that you can add your own 
product descriptions, images and customized pay buttons. 

Pinterest Pin It Widget 
Use this widget to add a Pin It button to your page. To pin something on your 
page, click the Pin It button and then select the image you want. 
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Responsive Image Gallery [Responsive] 
Six different layout styles let you create dynamic Image Galleries for your 
responsive website with this highly customizable widget.  

Text Section Widget [Responsive] 
Combine text, images and buttons together to create flexible responsive layout 
designs. The widget has an incredible range of styling options including an 
option to include multiple buttons. 

Twitter Follow Me Widget 
This widget allows you to add a Twitter Follow Me button to your page. Simply 
drag and drop the widget on the editor, and on the Widget Settings tab, enter 
your Twitter handle.  

Video Widget [Full Width Capable] 
If you want to add in MP4 Video, WebM or OGG video content to your website, 
this is the widget you need! 

Vimeo Widget [Full Width Capable] 
The Vimeo Video widget lets you easily embed Vimeo Video content to your 
website. 

YouTube Video [Full Width Capable] 
To embed a YouTube video on your website, you can drag and drop the 
YouTube Video widget onto the editor. On the Widget Settings tab, type in or 
paste the link for the YouTube video you want to embed. When you are 
finished, click the Apply button. You can modify the size of the video to suit 
your needs. 
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11Blogging

EverWeb includes a powerful, fully integrated and 
feature rich blogging environment so you can create 
the blog that you’ve always wanted.

Creating a Blog

The Blog Main and Archive Pages

The Blog Posts Window

Importing Blog Posts In To EverWeb

The Blog Editor Window

The Blog Preview Window

Adding Commenting to your Blog

RSS Features and Blogging
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Blogging 

EverWeb lets you easily create your own online journal with its powerful, easy 
to use, blogging environment (see Figure 11.1). Your journal, known as a ‘blog’, 
can include one or more articles, known as ‘posts’. Posts are great for writing 
longer, in depth articles that you want to keep separate from your regular web 
pages. Posts can also be short articles too, e.g. news items or announcements.  

You can format your blog posts in a number of different ways to suit your style. 
Blog posts are listed in an ‘Index’ page which shows your latest posts. Older 
posts can be accessed from a built in ‘Archive’ page. 

This chapter describes EverWeb’s blogging environment when using a Fixed 
Width page layout. If you want to design a responsive blog, or want to convert 
an existing Fixed Width layout blog to a responsive design, please refer to 
Responsive Blogging in the Responsive Websites in EverWeb chapter for more 
information. 
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Blogging Basics 
Creating a Blog 

 

To create a new blog, click on the ‘Add Page’ button in the 
Toolbar. In the Template Chooser, select a Theme from the left 
hand column that has a ‘blog’ page or select the ‘Blank’ Theme 
Template to design your own blog theme.  

Click on the ‘blog’ page from the template pages on the right 
hand side then click the ‘Select’ button. 

Your blog will be created in the Web Page List on the left hand side of the 
EverWeb User Interface. 

The blog has three pages (see Figure 11.2): 

• The Blog Main page is a directory page that acts as the blog’s ‘Index’ 
page. The Blog Main page lists the most recent blogs that have been 
created. The Blog Main page contains the ‘Posts’ page and the ‘Archive’ 
page. 

• The Posts page is where you create, edit, 
format and manage your blog posts and 
is the page you will probably use the 
most. 

• The Archive page is where older posts are 
listed. 
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Figure 11.2: EverWeb’s Blog 
Structure in the Web Page List
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Renaming a Blog 
To rename your blog, just double click on the word ‘blog’ in the Web Page List 
and overtype it with a new name. Press enter to finish. Alternatively, use the 
File-> Rename menu option. 

You can only change the name of the Blog Main page. The ‘posts’ and ‘archive’ 
pages cannot be renamed. 

Deleting a Blog 
Deleting a blog works in the same way as deleting any other pages in 
EverWeb. Click on the Blog Main page in the Web Page List, then press the 
backspace key on your keyboard. 

Warning! Deleting the Blog Main page will delete the whole blog structure. The Blog Main 
Page, the archive page and ALL of the blog posts will be deleted! 

If you delete the Blog by accident, immediately press Cmd+Z to undelete it. 
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The Blog Main & Archive Pages 

The Blog Main and Archive pages use a ‘widget’ to display the list of blog posts 
that have been created. Blog posts are displayed in date order. The latest blog 
post is at the top of the list and the oldest at the bottom (See Figure 11.3). Each 
blog post displayed shows the blog post’s Title. You can optionally show the 
date the post was published under the Title and some of the blog post’s text if 
you want. 

The widget has a selection handle on each side so that you can change the 
width of the widget as you want. The height of the widget adjusts 
automatically as you change the Widget Settings, add new blog posts, or other 
formatting such as font size. 
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Figure 11.3: The Blog Main page showing a list of blog posts. The whole list is contained in the Blog Main 
‘widget’ that has a selection handle on each side. The Widget Settings are shown on the right.
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Customizing The Blog Main & Archive 
Pages 

The Blog Main and Archive pages are customized in the same way as each 
other. In this example, to customize the Blog Main page, first click on the ‘blog’ 
page in the Web Page List. 

If you do not see the selection handles on either side of the widget, click once 
inside the widget to display them. Next select the Widget Settings tab (see 
Figure 11.4) in the Inspector Window. You now have a number of options 
available to customize the look of the widget e.g. to display only the first 100 
characters of your blog post’s text change the Article Length setting from 150 
to 100. If you want to include pagination buttons check the ‘Show Pagination 
Buttons’ box and so on. 

You can easily change the text formatting options of the widget. First click on 
the Fonts button in the Toolbar. With the Fonts Panel on screen, double click 
on either a blog post title, a blog post date (if you have it displayed), the text of 
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Figure 11.4: When you click on any item in the Blog Main widget, e.g. a title, all of the same type of item are 
highlighted so you can apply formatting to them all at the same time.
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a blog post, or the full archive link or pagination. buttons if you have added 
these to the page. All of the same items will be highlighted e.g. all of the blog 
post titles (see Figure 11.4). Select the fonts you want to use for the selected 
item from the Fonts Panel. 
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Formatting Blog Post Titles 
Blog post titles are actually hyperlinks to the blog posts themselves.  

That’s why they’re displayed in the default hyperlink styling of blue, underlined 
text. To alter the hyperlink colors and underlining, first select the Titles as 
described above.  

Next go to the Hyperlinks tab in the Inspector Window. In the Hyperlinks tab 
you can set the color and underline for normal, hover and visited states.  

For more information please see the section on the Hyperlinks tab. To change 
the font styling of the Titles use the Fonts Panel as described above. 

Formatting Blog Post Dates & Content 
Summaries 
Just as with blog post Titles, double click on any post date or content summary 
to change its formatting. Once selected, click on the Fonts button in the 
Toolbar to open the Fonts Panel to make your changes. 
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The Blog Posts Window 

The Blog Posts window is the heart of your blogging experience in EverWeb. It 
has four sections (Figure 11.5): 

1. The Blog Posts List at the top lists all of the blog posts you have created 
(see Figure 11.5 - Section A) 

2. The Blog Editor Window in the middle is where you add the blog post 
text. You can also add images, hyperlinks, lists and format your text (see 
Figure 11.5 - Section B). 

3. The Blog Preview Window at the bottom is where you see the 
formatted blog post including the blog post title, date and comments 
section if you have included these (see Figure 11.5 - Section C). 
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Figure 11.5: EverWeb’s Blog Posts Window has four sections: The Blog Posts List, the Blog Editor window 
and the Blog Post Widget Settings 
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4. The Widgets Settings tab where you can change styling settings for 
individual blog posts or all your blog posts (see Figure 11.5 Section D). 
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The Blog Posts List 
The Blog Posts List is where all the blog posts you have created are listed and 
managed. 

Creating a Blog Post 
Once you have created a blog, click on the Posts page in the Web Page List. 
The first blog post has been automatically created for you. To add more posts, 
click the ‘New Post’ button and enter the blog post title. Press enter to finish 
creating the new post. 

Drafting a Blog Post 
When you create a blog post, you may not want it published when you publish 
you website as it may be finished yet! If this is the case, tick the checkbox in 
the ‘Draft’ column for the post that you do not want to publish yet. When you 
are finished writing the post and want it published, just uncheck the Draft 
checkbox. 

Duplicating a Blog Post 
To duplicate a blog post, secondary click on the blog post you want to 
duplicate, then select ‘Duplicate’ from the menu.  

Deleting a Blog Post 
To delete a blog post, click on the post you want to remove in the Blog Posts 
List then click the ‘Delete Post’ button. 

Renaming a Blog Post 
To rename a blog post, double click on the blog post’s name in the Blog Posts 
List and type over the name that’s there already. Press enter to finish. 
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Alternatively, highlight the blog post and use the File-> Rename menu 
command if you prefer. 

Changing the Blog Post Date and/or Time 
To change the date and/or time the post was created, double click on the blog 
post date in the ‘Date’ column and enter the new date and/or time. Click 
outside of the calendar window to finish. 

The post date/time can also be synchronised to the date and time that the 
website is published by ticking the ‘Use Website Publish Date’ field. 

Changing the Blog Posts List Sort Order 
To sort the Blog Posts List in ascending or descending alphanumeric order, 
click on the words ‘Blog Posts’ to toggle the sort order. Click on‘Date’ to sort 
the blog posts from newest to oldest or oldest to newest. 

Resizing the Blog Posts List 
The Blog Posts List can be resized to display more, or less, blog posts. Move 
your mouse pointer to the line between the bottom post in the list and the row 
of buttons. The cursor will change to a splitter line. Click and drag up or down 
the splitter line up and down as required then release the mouse button when 
you are done. 
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Importing Blog Posts Into EverWeb 
EverWeb can easily import blog posts from other sources such as iWeb or 
WordPress using the ‘Import’ button (see Figure 11.5 - Section A). 

You should already have created a blog within EverWeb so that you can then 
import your existing blog posts from iWeb or WordPress. 

Importing Blog Posts from iWeb 

1. Before importing your iWeb blog entries into EverWeb, first use iWeb 
to publish your iWeb website to a folder on your local hard disk. 

2. After publishing your iWeb website to a folder, click on the Import 
button in EverWeb’s Blog Posts List Window.  

3. Select ‘iWeb’ from the drop down menu and click on the ‘Import’ 
button.  

4. Navigate to where you published the iWeb website on your local hard 
disk and select ‘Open’.  

5. EverWeb will list the blogs that it has found e.g. ‘blog’. Select the entry 
you want from the list and select ‘Import’.  

6. Your iWeb blog entries will be processed and listed as blog posts in the 
Blog Posts List. 
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Importing Blog Posts from WordPress 

1. Before importing your WordPress blog posts into EverWeb, you will 
need to export your WordPress blog. 

2. First login to WordPress and go to the Tools->Export menu.  

3. Click on ‘Posts’ and select the settings you want to use.  

4. Next, press Export.  

5. When the export is complete, you can import the file In EverWeb. 

6. From the Blog Posts List click the Import button. Select WordPress and 
choose the .xml file that you exported from WordPress.  

7. The file will be processed and your WordPress blog posts listed in the 
Blog Posts List. 
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Importing Images in to your Blog Posts 
Images can be imported in to your blog posts. Simply drag and drop the 
image from its source location to either:  

1. The Blog Posts Editor window if you want the image to only appear on 
the currently selected blog post 

2. The Preview Window if you want the image to appear on all of your 
blog posts. 
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The Blog Editor Window 

Editing a Blog Post 
The Blog Editor Window is where you enter the text of your blog. Once you 
have created a new blog post, select the placeholder text ‘This is a sample blog 
post’ and start typing. You can also paste in text that you have copied to the 
clipboard. 

At the top of the Editor Window is the Editing Toolbar where you can quickly 
apply text formatting to your blog post (see Figure 11.6). The Toolbar works in 
much the same way as in word processing applications.  

You can resize the Editor Window height by hovering the mouse on the border 
line between the Editor and Preview Windows. The mouse pointer will change 
to a splitter symbol. Click and drag the splitter up or down until you have the 
Editor Window the size you want it, then release the mouse button. 
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Figure 11.6: The Blog Editor Toolbar contains frequently used editing features for quick access.
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Formatting Text in the Blog Editor 
As well as the formatting options in the Blog Editor Toolbar, there are other 
ways to achieve the look that you want for your blog text.  

The Text Inspector can be used to change blog text character spacing, line 
height, spacing before and after a paragraph and even insert a margin in the 
blog post widget itself.  

To use these options, just highlight the text in the Blog Editor Window then 
click on the Text Inspector tab and use the options listed. 
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Hyperlinking Blog Posts 
Linking a blog post to a page in your website is 
easy to do. Simply select the object on the page 
you want to link the blog post to e.g. a piece of text.  

Click on the Hyperlinks tab in the Inspector 
window (see Figure 11.7). Check the box “Enable as 
Hyperlink”.  

To link a blog post select “One of My Pages” from 
the Link To options. Next choose the blog post you 
want to link to from the drop down menu in the 
“Pages” option.  

The link is all set up so when someone clicks on the 
linked text they will go to the blog post. 
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Figure 11.7 The Hyperlinks tab.



EverWeb User Manual Blogging

Images in the Blog Editor Window 

Images can be drag and dropped directly in to the Blog Editor Window. Once 
you have dropped the image in from its source, or from the Assets List, click on 
the image to select it. The selected image has a blue border with square 
selection handles in each corner that you can drag to resize the image.  

A Blog Image Toolbar is displayed either above or below the selected image 
(see Figure 11.8). You can align the image to the left or right or not at all. You 
can also have the image display inline with the text or ‘breaking’ so that the 
text only displays above and below the image. There’s also an option to add 
Alternative Text to the image that is used by search engines to add keywords 
or context to your image that they can understand. 

If you have dropped the image on to the Blog Preview Window, the above 
options are not available. The next section tells you more about using images 
and objects in the Preview Window.  

www.everwebapp.com  of 136 207

Figure 11.8: The Blog Post Editor Window showing a selected image and the Image Editing Toolbar.
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The Blog Preview Window 

The Blog Preview Window is where you see how your blog post will look when 
published. It is similar to a Master Page as when you add, edit or delete objects, 
or change any formatting, these changes are applied to all your blog posts e.g. 
if you add social media buttons in the Blog Preview Window of one of your 
posts, the buttons will appear in all posts (see Figure 11.9). 

The text entered in the Blog Editor Window appears in the Blog Post Widget in 
the Preview Window as does the blog’s Title at the top. You can apply 
additional display and formatting options using the Blog Post Widget Settings. 
As such, what you see in the Blog Editor Window may appear differently in the 
Blog Preview Window due to the formatting that you may have applied. 

For example, the text may wrap at a different point if the blog widget is smaller 
than the blog entry field. 
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Figure 11.9: You can add objects such as social media buttons to the Blog Preview Window so that they 
appear on all of your blog posts in the same place.
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Blog Post Widget Settings 
You can format all of your blog posts to have 
the same look using the Blog Post Widget 
Settings tab. For example, if you change the 
font of the Blog Post Title in the Header 
Options, the change will be applied to all of 
your blog posts. 

There are many different options to choose 
from such as including the date of the blog 
post and Navigation Links that make it easy 
for your visitors to move through your blog 
posts of return to the Index (Blog Main) page. 

Use the Post Cover Image Options to add an 
image to the blog post. Set the Maximum 
Image Height and Width options for Fixed 
Width and Responsive pages to limit the size 
of the cover image. 

Formatting The Blog 
Post Preview Page 
The Blog Post Options change the formatting 
of the blog posts themselves. If you want to 
change other aspects of the Blog Preview 
Window, use the Inspector Window. For 
example if you want to change the 
background color of the blog posts, use the 
Page Settings tab and set the Page and 
Background color to how you want it. 
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Figure 11.10: The Blog Posts 
Widgets Settings including the 
Comments Options section.
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Adding Objects in to the Preview 
Window 
You can add in other objects such as images and buttons in to the Preview 
Window. When you do this, the object will display in all of your posts. This is 
very useful if you want to add, for example, social media buttons, or a company 
logo, to your blog posts (See Figure 11.9). The Preview Window is in many ways 
similar to the way in which EverWeb’s Master Pages work (see the following 
section for more information). 

Tip: To add an object just to one blog post, add the object in to the Editor Window. 
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Navigation Links 
You can include navigation links at the bottom of your blog so that visitors can 
easily go the next or previous blog or back to the Index page. By default, 
EverWeb displays these navigation links. If you do not want them, use the Blog 
Posts Widget Settings and deselect the ‘include navigation links’ and/or 
‘include index page link’. 

The navigation links can be customised using the Navigation Links ‘Fonts’ 
button. To change the color of the links, use the Post Link Normal, Hover and 
Visited options as the navigation links are hyperlinks to other pages in your 
website. 
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Adding Commenting To Your Blog 
You can let your visitors discuss and leave their own comments about your 
blog posts by using a ‘Comment Engine’. EverWeb allows you to use either 
Disqus or Facebook’s comment engine. Both comment engines require that 
you set up an account beforehand. 

Choosing Your Comment Engine 
You can choose to use either Disqus and Facebook Comments (see Figure 
11.10). Both offer similar features to each other although you may want to 
consider that… 

Disqus is better if you want real time conversations and an easy to use 
interface whilst 

Facebook Comments is better if you have a large number of website visitors 
using Facebook and for visitors who want their comments published in their 
Public Facebook profile. 
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Obtaining a User ID for Disqus or 
Facebook Comments 
Creating a User ID in either Disqus or Facebook Comments can seem 
complicated at first as each offers many different setup options. However, 
these options are not usually needed. All you need is the User ID itself to get 
started in EverWeb. 

The steps below will help guide you in setting up Disqus or Facebook 
Comments. As there are a number of different user situations, you may find 
that you need to complete only some of the steps shown, or you may need to 
complete more steps than are shown below. 
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Using Disqus as your Comment Engine 
 

1. First sign up for an account at the Disqus website if you don’t already 
have an account.  

2. You can use your Facebook, Twitter or Google accounts to sign up, or 
use your email address if you prefer. (See Figure 11.11) 
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Figure 11.11: Disqus Signup screen
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3. When you sign up, click on the‘Get Started’ button on the ‘#1 way to 
build your audience’ screen (See Figure 11.12). 

4. Next you will see the‘Create a new site’ screen (See Figure 11.13). The 
‘Site Owner’ will be the name you used as your sign up name. 
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Figure 11.12: Getting Started with Disqus 
Setup

Figure 11.13: The Create a new site screen
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5. When you enter your ‘Website Name’ (highlighted in the red box in 
Figure 11.13) you will see that Disqus automatically creates a 
‘shortname’ which will be the User ID. 

6. Make a note of your ’Shortname’ as you will use this later in EverWeb! 

7. Complete the details and click on ‘Create Site’. Your Disqus ID will be 
created and you will now be offered a number of customization 
choices. 

8. Click on the button ‘Yes, I understand Disqus is both comments and 
native Apps’ on the next screen. 

9. You will next see a screen with options to install Disqus on different 
platforms (See Figure 11.14).  

10. Click on the ‘Universal Code’ button at the bottom of the screen. 
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Figure 11.14: Choose the Universal Code option 
as your Platform
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11. Scroll to the bottom of the next screen and click the button. Continue 
to do this until you see the ‘Setup Complete’ screen (See Figure 11.15). 

You have now finished the setup process and have a Shortname that can be 
used in EverWeb.  
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Figure 11.15: The Setup Complete screen for Disqus
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Using Facebook as your Comment 
Engine 
To use Facebook as your comment engine: 

1. Sign up to Facebook at www.facebook.com if you do not have an 
account already. 

2. Once you have a Facebook account you will need a Facebook App ID. 
To do this you need to be a Facebook Developer (See Figure 11.16) 
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Figure 11.16: The Facebook Developers Home Page with the ‘My Apps’ button in the top 
right hand corner of the screen
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3. If you have not done so already, convert your Facebook account to a 
Facebook Developer account by selecting the ‘Docs’ menu.  

4. Click on ‘App Development’ in the ‘Product Docs’ or ‘Guides’ section, 
Next select ‘Creating an App ID’ from the ‘App Development’ list. 

5. Scroll down to ‘Developer Account’ and ‘click on ‘Create Developer 
Account’ (See Figure 11.17). 
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Figure 11.17: Select ‘Creating an App ID in the left column and then  ‘Create Developer 
Account’ in the right column.
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6. Once you have completed the registration you can add Facebook in to 
your app or website. 

7. Facebook will ask you which application platform you are using. If you 
have already registered, use the ‘My Apps’ button and select ‘Add a 
New App’ from the menu. 

8. Click on ‘WWW” for your website (See Figure 11.18). 
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Figure 11.18: The Add a New App screen. Select the ‘www’ option.
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9. In the ‘Quick Start for Website’ window, type in the name you want to 
call your app e.g. the name of your website and then click on ‘Create 
New Facebook App ID’. Remember to select a ‘Category’ as you cannot 
proceed if you don’t (See Figure 11.19). 

10. Once the App has been created, you will see the ‘Setup Facebook SDK 
for JavaScript’ screen. Enter your website URL at the bottom of the 
screen and click ‘Next’. 

11. Scroll down until you see the section ‘Next Steps’. ’ 

12. Click on ‘Skip to Developer Dashboard’. 
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Figure 11.19: The Create new App ID Screen.
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13. At the top of the Dashboard is your App ID number which you can now 
use in EverWeb (See Figure 11.20). 
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Figure 11.20: The Facebook Developer Dashboard showing the App ID at the top of the 
screen
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Enabling Comments in EverWeb 
Now that you have your Disqus Shortname or Facebook App ID, go to the 
Comment Options section in the Widget Settings of your Blog Posts in 
EverWeb (see Figure 11.10 above). 

In the Comment Engine section, select either Disqus or Facebook then enter 
your Disqus Shortname or Facebook Comments App ID in the box below. 

Your comment section is now setup! The Blog Preview widget will update 
showing the comment engine is enabled at the bottom of the widget. 

When your website is published to the Internet, visitors to your blog posts can 
add their own comments. A visitor will need to login to Disqus (or sign up 
which can be done via the login section in the Disqus Comments) or Facebook 
Comments (using their Facebook login) to be able to comment. 
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Managing Comments on Your Blog 
You are responsible for monitoring the comments that are placed on your blog 
by your visitors. As a ‘moderator’ you can approve comments for public display 
on your blog, delete comments from your blog (e.g. if they are offensive) and 
tackle instances where your blog may be subject to spam. 

If you are using Disqus commenting please go to their moderator guidelines 
for more information. 

If you are using Facebook commenting please go to their online help resource 
center. 
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RSS Features and Blogging 

Your website visitors can always stay up to date with the blogs that you create 
in EverWeb through RSS.  

There are a couple of easy ways to use RSS to take advantage of your blogs. 

• The RSS Feed Widget 

• The RSS Subscribe Button 

These features are described below. 
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The RSS Feed Widget 

You can use EverWeb’s RSS Feed Widget to show a blog summary on your 
web pages (See Figure 11.21) To do this, first go to the page where you want to 
add the blog summary. Next go to the Widgets Tab in the Inspector Window 
and drag and drop the RSS Feed Widget on to the page. 

In the Widget Settings you will now need to add in the location of your Feed 
URL. This location contains an rss.xml file that enables the blog entries to be 
displayed. the rss.xml file is located at 

 http://<your website address>/blog/rss.xml 
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Figure 11.21: Use the RSS Feed Widget to add your latest blog posts to any page in your website
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For example, Josh’s real estate business that we met earlier in the manual has 
created a blog for his website. His Feed URL may look like this 

    http://www.joshsrealestate.com/blog/rss.xml 

Once you have added the Feed URL choose which other options you want to 
use in the RSS Feed Widget Settings. then publish your website to see the 
results displayed.. 
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The RSS Subscribe Button 
 

You can add an RSS Subscribe button to your website so that your visitors can 
easily keep up to date with your blogging. 

To add an RSS button just use the Insert-> Button-> RSS Subscribe menu.  

Select from the menu to either subscribe to the website project’s blog using 
‘Select Blog’ or from another location using the ‘Enter URL’ option (see Figure 
11.22). 

Your button will be placed on the web page so that your visitors can subscribe 
to your blog using RSS. 
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Figure 11.22: The RSS Subscribe Button lets your visitors subscribe to your blog
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12Previewing & 
Publishing Your 
Website

Whilst building your website it’s a good idea to preview 
your web pages to see how they will look before going 
live.

When your website is complete, you can then Publish it 
to the Internet!

Previewing Your Website

Preview Server

Publishing Your Website

EverWeb+Hosting Accounts
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Previewing & Publishing Your 
Website 
Using Preview 
Whilst building your website and before you publish your website to the 
Internet, it’s a good idea to preview your web pages to see how they will look 
before going live. 

It’s also a good time to test out some  the features of your website such as the 
navigation and hyperlinks.  

Preview takes advantage of the browsers installed on your computer. On a 
mac, Safari is installed but it is recommended that you install other browsers 
such as Google Chrome, Opera, Firefox etc, in your mac’s Application folder so 
that you can test your website in as many different browsers as possible before 
publishing 

To preview your website, click on the Preview button in the 
Toolbar. You will see a list of all of the browsers that have been 
installed on your computer. Select the browser of your choice. 
EverWeb will process your website files then preview the results 
in your browser. 

You can test out most features of your website in Preview. Please note that 
some features may not work as they e.g. Contact Forms, as they may require 
publishing to the Internet in order to work properly. 
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Preview Server 
EverWeb uses a Preview Server so 
that you can preview your website on 
any device that is attached yo your 
local network.  

To use the Preview Server 
functionality, go the the EverWeb-> 
Preferences-> General tab.  

Make a note of the HTTP address in 
the ‘Remote URL’s’ section. 

Preview your website on your 
computer using the Preview button 
in the Toolbar. 

Next, go to another device on your 
local network e.g. an wifi connected 
iPad. Open your browser and enter 
the Remote URL’s address that you 
noted earlier.  

You will see an Index page. Select the second item in the list which has the 
same name as the page you previewed on your computer. You will see the 
same preview on your iPad as you on your computer. 

Caution 
Some web browsers, such as Google Chrome, do not fully support this 
functionality. If you use Google Chrome as your default browser it is 
recommended that you turn off EverWeb’s Preview Server. You can do this in 
the EverWeb-> Preferences-> General tab (See Figure 12.1). 
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Figure 12.1: EverWeb ’s General Preferences showing 
Preview Server.
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Publishing Your Website 

When you are ready to publish your website in EverWeb, click on the Publish 
button in the Toolbar.  

If this is your first time publishing in EverWeb, you will see a popup window 
appear. Sign in to your EverWeb account in order to publish your website. (See 
Figure 12.2). 

If you do not have an EverWeb account and want to create one, click on the 
‘Create Account’ button to register an account. 
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Figure 12.2: Log in to your EverWeb account in order to publish 
your website.
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If you have an EverWeb account, you can click on the Sign In button, which will 
bring up the Preferences window (see Figure 12.2).  

In this window, you will be able to enter your EverWeb email login and 
password. When you are done, click on the Sign In button. 

Once you are signed in to your EverWeb account, you will not need to enter 
login information again unless you Sign Out. 

Once logged in, click on your website name to view the Publishing Settings. 
Under the Publishing heading, you can choose to publish to your EverWeb 
Hosting account, to a local folder or to a third party FTP server. 

If you are publishing to EverWeb, you will see the ‘EverWeb Location’ settings 
as shown in Figure 12.3. 

 

Under the Accounts drop down menu, you can choose which EverWeb 
hosting account you wish to publish to. You will most likely only have one 
account so you can leave this as is.  

If you have more than one domain on the account, you will see a Domains 
drop down, which will allow you to choose which domain to publish to. If you 
only have one domain, you will not see this menu. 
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Figure 12.3: Users publishing to their EverWeb Hosting account can select from their multiple 
accounts, and multiple domains, as applicable. 

everwebtutorials.com

domain2.com
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The Subdirectory field (see Figure 12.4) allows you to publish your website to a 
different location on your server. 

The’Subdirectory’ location can be used for testing purposes before your 
website goes live. 
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Figure 12.4: The Subdirectory field allows you to publish your website to a different directory on the server. This 
is useful as you can publish to a temporary location for testing purposes without overwriting an existing website.

everwebtutorials.com

everwebtutorials.com

temporary
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For example, entering the word 'temporary' would publish the site to 

http://www.everwebtutorials.com/temporary 

rather than at  

http://www.everwebtutorials.com.  

The current website published at http://www.everwebtutorials.com would not 
be overwritten. 

 

If you want to publish your site without the Subdirectory, leave 
the Subdirectory field blank. 

When you are ready, click on the Publish button in the Toolbar, 
and EverWeb will publish your website. 

www.everwebapp.com  of 164 207



EverWeb User Manual Responsive Websites in EverWeb

Head and Footer Code 
You will notice that there is a field for Head and Footer code. This is an 
advanced feature that lets you add custom code that gets place within the 
Head section of your website or right at the bottom of your website. 

This is useful for adding Google Analytics, Statcounter.com or custom 
Javascript code. 

Adding Google Analytics 
The Footer field can be used to add your Google Analytics code. Just copy and 
paste your Google Analytics code to this field. 
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EverWeb + Hosting Accounts 
If you do not have an EverWeb account you can create one here.  

EverWeb+Hosting account pricing starts at $99.95 USD/year and provides web 
space and personal email addresses. It also provides free updates and support 
while your account is active. 

When you create an account you will be asked to make a password. This 
password, with your email address, is all you need to publish your website. 

Once your account is created enter your Email address in the ‘Email’ field and 
your password in the ‘Password’ field and click ‘Sign In’.  

Under the ‘EverWeb Location’ header you will see your website address (also 
known as your domain name) in the ‘Accounts’ drop down menu. It should be 
automatically selected for you. 

If you want to secure your website using end to end data encryption and 
receive a rankings boost from Google and other search engine providers, tick 
the ‘Use HTTPS Secure URL’s’ box. For more information about this, please refer 
to the ‘EverWebSite Shield Addon’ section at the start of the User Manual. 

The ‘Subdirectory’ field should only be used if you have multiple websites 
under one account. It lets you have a unique website address for each website 
and will prevent any websites from being overwritten. 

Tip: If you want to have multiple websites you don’t have to worry about your website being 
overwritten. Just enter a unique subdirectory for your second website. EverWeb will warn you 
if you are overwriting an existing website previously published through EverWeb. 
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Setting Up Personalized Email Addresses 
EverWeb makes it very easy to create and manage personalized email 
addresses. These emails addresses will use your domain name in them. 

 

To setup an email address to be associated with your domain name: 

1. Scroll to the bottom  of the Publishing Settings Screen. 

2. In the Email Addresses section (see Figure 12.5), click on the Add 
button. 

3. In the popup window, type in your desired email name and select the 
domain you want to associate it with from the drop down menu. If you 
only have one domain, you will not need to select the domain. 

4. Type in your desired password and then retype it to confirm. When you 
are done, click on the Create button. 

5. You should now see your email address in the list. 
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Figure 12.5::Setup personal email addresses in EverWeb.



EverWeb User Manual Responsive Websites in EverWeb

Using Email Addresses in Apple Mail 
If you want to configure your email address in Apple's Mail application, select 
the email address from the list and then click on the ‘Configure in Mail’ button. 

You will see a popup window letting you know that incoming and outgoing 
email settings were successfully setup. Press the ‘OK’ button. 

Now, open Mail, and you will see that your email address has been added. 

Tip: When you click on the Send Email button, you might see a Verify Certificate popup 
appear. You can either click on the Connect button to continue, or click on the Show 
Certificate button, and then check the option to ‘Always Trust’ the server when connecting 
your email. This is perfectly safe to do and we recommend it. 
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404 Not Found Page 
A ‘404 Not Found Page’ lets you assign a page in your website to display if a 
visitor tries to access a page that doesn’t exist.  

This usually happens if  

• There is an an outdated link on your website 

• If the user mistypes the web page name in the browser’s search box 
when looking for a page on your site 

• If you have updated your site and removed an existing page. 

Adding a page to your website to capture such instances makes your website 
more professional. It also help keep your visitors in your website. 

Create a ‘404 Error Page’ in your website to redirect the user to another page 
in your website.  

Remember to also create a page for your mobile website as well as your 
desktop website. 
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FTP Publishing 

EverWeb lets you publish your website to any web hosting provider by the FTP 
Server Publishing option. EverWeb supports: 

• FTP 

• FTP with SSL Protocol  

• FTP with SSH Protocol.  
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Figure 12.6: FTP Settings in Site Publishing Settings
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To publish to your FTP Server,  

1. First access the Site Publishing Settings of your website Project using 
the File-> Edit Publishing Settings, or by clicking on the name of your 
website Project in the Web Page List. 

2. The Editor Window will now display your Site Publishing Settings 
(Figure 12.6). 

3. Set the ‘Publish To” location to ‘FTP Server’. 

4. Complete the FTP Server Details section. If you are unsure of your FTP 
publishing settings, please contact your web hosting provider who 
should provide these details. 

Username and Password Fields 
Remember to pay special attention to the username and password field in the 
FTP Server Details section. Your Hosting Provider may have set up a user 
account username/password for you and also a separate FTP login username/
password.  

Your Hosting user account lets you login to your Hosting Provider’s website to 
access billing and account details. 

In contrast, your FTP login details are used in EverWeb’s Site Publishing 
Settings. So remember to check that you are using the right login as using the 
wrong login can result in authentication errors when trying to publish. 

The other field to pay attention to is the Directory/Path field. This is the 
directory path to the location where your web page files are stored. The 
Directory/Path location can differ between web hosting providers. 

If you are not sure of what to enter in this field, check with your Hosting 
Provider. An incorrect file path can cause your website to be published to the 
wrong location and not accessible via your web browser. 

Once you have entered in your FTP Server Details, you can use the ‘Test 
Connection’ button to check if the connection to your Hosting Provider’s server 
is working correctly. 
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Publishing Preferences 
To improve the speed of publishing your website, you can take advantage of 
multiple connections from your computer to your Hosting Server.  

 

Use the ‘Maximum 
Connections’ drop down 
in the Publishing tab of 
the EverWeb-> 
Preferences menu to 
change the number of 
connections you want 
to use when publishing 
(see Figure 12.7). 

The more connections 
that are in use, the 
faster the publishing of 
your website. However, 
with more connection 
in use, publishing may 
become less reliable.   

The fewer connections 
will result in slower but 
more reliable 

publishing. 

Some hosting providers limit the number of connections that can be used, 
usually to around 5 connections. 
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13Responsive Websites 
in EverWeb

This chapter introduces you to Responsive Web Design, 
how it works in EverWeb and how to create your first 
responsive website. 

EverWeb’s Responsive Web Design features are only 
available in EverWeb version 2.8 or higher.

Introduction

What Is Responsive Website Design?

Responsive or Traditional Design?

EverWeb’s Responsive Web Design Features

Creating a Responsive Website

Creating a Responsive Page

Responsive Page Structure

The Responsive Row Widget

Widgets & Responsive Pages

The Responsive Row Widget

Testing Your Responsive Page

Responsive Blogging
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Responsive Websites in EverWeb 

Introduction 
This chapter introduces you to Responsive Website Design (RWD)in EverWeb 
and how to create your first responsive website.  

If you are new to creating responsive websites in EverWeb you will need to 
learn about responsive design concepts and how they work within EverWeb. 

Before starting your first responsive website, it is advantageous to have an 
understanding of EverWeb itself. The previous chapters describe EverWeb’s 
features and functions in detail and how to build a ‘traditional’ website. Most of 
these features and functions can also be applied to a responsive website 
design. It is recommended that you review the previous chapters before 
starting your first responsive website if you are not familiar with EverWeb. 

What is Responsive Website Design? 
Responsive Web Design is an approach whereby web pages automatically 
scale to suit the device on which they being viewed upon using one only page 
design.  

This approach differs from ‘Traditional’ website design which is where you 
develop separate desktop and mobile web pages, then link them together 
with a built in redirect. Your visitor will be ‘directed' to the appropriate page, 
desktop or mobile, depending on which device the website is being viewed 
upon.  

Content First 
In Responsive Web Design your page content is of primary importance. 
Content can be text, or an image, shape or media such as audio and video and 
so on.  
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Content automatically rescales to suit the device it is being viewed on from 
wide desktop computers down to mobile phones and everything in between. 
As such, your content will need to be consistent across devices and EverWeb 
makes this easy and flexible to do. However, it is always important to test your 
design across different types of device to make sure it always displays correctly. 

Responsive or Traditional Design? 
Responsive Website Design was created to make development of fully 
scaleable websites quick and easy. However, there may be times when a 
responsive website may not be the best approach. 

If you are unfamiliar with responsive design it is recommended that you build 
a test website first. Investing some time and effort in experimenting with 
responsive design will help you learn about how it works in EverWeb. 

If you want to redevelop an existing 'traditional' style website in to a responsive 
website design, this will probably require some design compromise in the 
process. Do not expect your responsive design to look and/or function in 
exactly the same way as your traditional website design. Responsive website 
design is more structured than traditional website design which is more free 
form in approach. 

The following lists some of the advantages, and disadvantages, of responsive 
website design compared to traditional website design:  

Advantages of Responsive Web Design 
• Your website design is automatically scaleable on any device. 

• Google likes responsive websites and ranks Responsive websites 
higher in Search Engine Results Page rankings pages. 

• Responsive design promotes website design unity across devices 

• Requires only one website that caters for all devices 
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• May reduce development and maintenance time, cost and effort 

Disadvantages of Responsive Web Design 
• Responsive website design is conceptually difficult and difficult to 

learn. 

• Constrained design approach. Typically, responsive website design is 
not a good for creating free form websites. 

• May increase development and maintenance time, cost and effort 

• Page loading times can be slower than for ‘Traditional’ websites. 
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EverWeb’s Responsive Web Design 
Features 
Before you start building your first responsive website, it is important to get to 
know EverWeb’s Responsive design features. This will save you time, effort 
and potential frustration and will make your website planning, design and 
building tasks easier. 

1. EverWeb 
To build responsive websites in EverWeb you will need version 2.8 or higher 
installed on your computer. 

2. Responsive Themes & Pages 
When adding a responsive page to your EverWeb project, you can choose to 
see only Responsive Theme Templates by selecting ‘Responsive’ from the 
dropdown menu in the top right hand corner of the Theme Template Chooser. 

Next, click on the Responsive Theme that you want to use from the left 
column and then the page style you want from the right side of the Theme 
Template Chooser. 

To create your own design from scratch, use a blank responsive page. In the 
Theme Template Chooser you can select the ‘Home’ page of the Blank 
Responsive Theme Template or use the ‘Responsive’ page style in the Blank 
Theme Template. 

3. Responsive Page Layout 
Responsive web pages in EverWeb use a ‘Responsive’ page layout as indicated 
in the Page Layout section of the Page Settings tab of the Inspector Window. 

When using the Responsive page layout, objects on the page scale 
appropriately on any device on which they are displayed. Only the following 
options are available in the Page Layout section of the Page Settings tab when 
using Responsive layout: 
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• Top Margin  

• Content Height 

• Footer Height 

4. Responsive Widgets 
EverWeb includes a number of widgets specifically designed to take 
advantage of responsive page design: 

• Responsive Row Widget 

• Responsive Image Gallery Widget 

• Text Section Widget 

• FlexBox Widget 

5. The Responsive Row Widget 
The Responsive Row widget is one of the cornerstones of responsive design in 
EverWeb. This special widget acts as a ‘container’ that you can drag and drop 
TextBoxes, shapes, images and other widgets into. The Responsive Row 
Widget is discussed in more detail in the next section. 

6. Responsive Ready Widgets 
Most of EverWeb widgets are Full Width capable e.g. the Navigation Menu and 
Image Slider widgets.  

Other widgets, such as the PayPal and Facebook Like widgets are not full 
width capable and so need to be placed inside a Responsive Row widget to 
function properly. If you try to add a widget that is not Full Width capable to a 
Responsive page you will see a warning message (Figure 13.1). 
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The following widgets need to be placed in to a Responsive Row Widget to 
work properly: 

• RSS Feed Widget 

• Image Gallery Widget (Use the Responsive Image Gallery Widget Instead) 

• Contact Form Advanced Widget 

• Facebook Like Widget 

• Facebook Page Timeline Widget 

• Google Plus Widget 

• Live Photo Widget 

• PayPal Widget 

• Pinterest Widget 

• Twitter Follow Me Widget 
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Figure 13.1: EverWeb’ will warn you if you try to add a non-Full Width widget to a Responsive page 
layout and advise you how to proceed.
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7. The Navigation Menu Widget 
EverWeb's Responsive Navigation Menu Widget includes a Responsive 
Options section so that the navigation menu can automatically adjust 
according to the screen width. 

8. Pick Layer 
To select a full width object on a page, e.g. a Responsive Row widget, you only 
need to click on the full width object itself.  

When using a Responsive page layout, you will not see any grab handles on 
the left and right vertical sides of full width objects, as full width objects always 
scale to fill the available page width. 

Some full width widgets have grab handles in the center of their top and 
bottom edges so that you can adjust their height. When used at full width, 
objects such as the Navigation Menu widget, Responsive Row widget, 
TextBoxes, shapes and images can be height adjusted. 

Some full width widgets cannot be height adjusted due to the functionality of 
the widget itself e.g. the FlexBox widget, and the Responsive Image Gallery 
widget. In this case, no grab handles appear even when the full width object is 
selected.  

In such instances where you need to specifically select a full width object, use 
Pick Layer. This feature ensures that you have the right object selected. To use 
Pick Layer: 

1. Secondary click on the object you want to select 

2. Mouse down to the ‘Pick Layer’ option in the popup menu. 

3. A sub menu will be displayed showing the ‘layers’ that can be selected. 
Click on the layer that you want to select e.g. Responsive Row’. 

9. Embed In 
Pick Layer lets you specifically select an object. The ‘Embed In’ option lets you 
place a selected object within a Responsive Row widget. For example, if you a 
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responsive row widget to your page, you may want to add a TextBox inside it. If 
however, the responsive row widget is not selected when you add a TextBox 
from the Toolbar to the page, the TextBox will be placed below the Responsive 
Row widget and not inside it. The TextBox will also, in this instance, be a full 
width rather than a non-full width object that it would have been if it was 
correctly placed inside the Responsive Row widget. 

To move the TextBox into the Responsive Row widget: 

1. Select the Full Width TextBox 

2. Secondary click on the TextBox. A menu of options will appear 

3. Click on the ‘Embed In’ option. A list of the Responsive Row widgets 
that are used on the page appears. 

4. Select the Responsive Row that you want to place the TextBox in. 

5. The TextBox is placed within the Responsive Row widget as a full width 
object. 

6. To make the TextBox a non-full width object, go to the Metrics 
Inspector and deselect the ‘Full Width’ checkbox. You will now be able 
to adjust all of the TextBox’s dimensions. 

 

10. Show On Device 
The Metrics Inspector includes a 
‘Responsive’ section (See Figure 13.2). You 
can use the ‘Show on…’ Device checkboxes 
to control on which devices an object will 
be displayed upon. The four device types 
are mobile, tablet, desktop and wide 

desktop.  
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Metrics Inspector.
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When an object is hidden you can reveal it by either secondary clicking on the 
page, selecting Hidden Objects then choosing the object you want to show, or 
by using the Window-> Show Hidden Objects menu option. 

The Show on Device option can be used for objects on either Responsive or 
Fixed Width page layouts. 

Note: Full Width Section objects on a responsive page cannot be hidden per device. However, 
objects within a Responsive Row can be hidden, allowing you to add objects that only appear 
on your page on specific devices. 

11. Breakpoints 
Use breakpoints to set the point at 
which a responsive page will 
respond to a change in device. 
Using breakpoints ensures that a 
responsive page will always format 
and display objects correctly on 
each device type.  

Click on the ‘Breakpoints’ button in 
the Inspector or go to the Insert 
menu -> ‘Breakpoints…’ to set the 
page width for mobile, tablet and 
desktop devices (See Figure 13.3). 
To reset the values back to their 
original setting click on the ‘Set 
Default’ button. In the Breakpoints 
dialog box. 

The Breakpoints dialog lets you set the maximum width for each device. 
Anything larger than Desktop will be considered ‘Wide Desktop’. 

Breakpoints are displayed as dashed vertical lines in the Editor Window. To 
toggle this display on and off, use the Window-> Hide/Show Breakpoints menu 
option. 

www.everwebapp.com  of 182 207

Figure 13.3: Use Breakpoints to manually define page widths 
for mobile, tablet and desktop devices.
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12. Margins 
When using a Full Width object in your page design, you may find that its 
content is goes right to the edges of the page. Use the Margins option in the 
Metrics Inspector to add left and right margins so that the content is better 
placed on the page. 

Similarly, you may want to add more space at the top and bottom of the full 
width object. This can be achieved in a number of different ways e.g. using the 
top and bottom Padding options in the Responsive Row widget, the top and 
bottom margin options in the FlexBox widget, full width shapes above or 
below the current full width object, using margins options in the Text 
Inspector etc. Choose the option that is most appropriate to your page design.  
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Creating a Responsive Website 

Introduction 
This section of the chapter takes you through creating a responsive page and a 
responsive blog page.  

Creating a Responsive Page 

The following instructions can be used to create a Responsive page or a 
Responsive Master Page. The general process is the same. 
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1. If you are creating a new project, click on the ‘Create a new website’ 
button on the Projects Window. The Theme Template Chooser will 
appear (See Figure 13.4). To quickly find Responsive Theme Templates, 
click on the filter drop down menu in the top left hand corner of the 
Theme Template Chooser. Select Responsive from the drop down. The 
list of Theme Templates in the left hand column will now display only 
Responsive Theme Templates. 

2. Select the Responsive Theme Template you want to use in the left hand 
column then select the page style you want from the right hand side. 

3. To create a blank responsive page select the ‘Blank Responsive’ Theme 
Template in the left hand column then the ‘Home’ page style from the 
right hand side. Click the Select button to finish,  

4. To add a responsive page to an existing project, use the ‘Add Page’ 
button in the Toolbar. To quickly find Responsive Theme Templates, 
click on the filter drop down menu in the top left of the Theme 
Template Chooser and select ‘Responsive’. The list in the left column 
will now display only EverWeb’s Responsive Theme Templates. Select 
the Responsive Theme Template you want to use and then the page 
style from the right hand side. To create a blank responsive page select 
the ‘Blank Responsive’ Theme Template in the left column and then 
the ‘Home’ page style from the right.. Click ‘Select’ to finish,  

5. You have now created a responsive page in your website project. 

6. Rename the page by double clicking on the page name in the Web 
Page List and name it as required. Press Enter to finish. 

Creating a Responsive Master Page 
1. Creating a responsive Master Page uses the same process as creating a 

regular responsive page. However, instead of using the ‘Add Page’ 
button, use the ‘New Master Page’ button in the Master Page area of 
the Web Page List.  

2. To quickly find Responsive Theme Templates, click on the filter drop 
down menu in the top left of the Theme Template Chooser (See Figure 
13.2). Select ‘Responsive’.  

3. The list in the left column will now display only Responsive Theme 
Templates. From the Theme Template Chooser select the Responsive 
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Theme Template you want to use then select the page style from the 
right hand side.  

4. To create a blank responsive Master Page select the ‘Blank Responsive’ 
Theme Template in the left column then the ‘Home’ page style from 
the right hand side. Click ‘Select’ to finish, 

When you. create a Responsive page the ‘Page Layout’ in the Page Settings 
tab of the Inspector Window will be ‘Responsive’. The 'Content Width’ and 
‘Header Height’ fields are not available as they are not used in responsive 
design. 

Changing The Page Layout 
EverWeb uses three page layout styles: Left Aligned, Centered and Responsive. 
You can change the Page Layout of your page to a different type of layout if 
you want. However, when doing so the design of the page may be radically 
changed. Therefore you will not be able to undo this action. EverWeb will warn 
you if you decide to change the Page Layout style. See figure 13.5. 
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Figure 13.5: If you change the Page Layout from one type to another, EverWeb will warn you first as 
making a change to the page layout cannot be undone afterwards.
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Responsive Page Structure 
Responsive website design uses containers, known as sections, that keep 
objects in a formal structure. Sections have the following features: 

• Sections are always horizontal across the page; 

• Sections always take up the Full width of the page no matter on what 
type of device the page is being displayed upon. 

• An object can be a section in its own right if it is Full Width capable e.g. 
the Navigation Menu widget, a TextBox or a shape can all be full width 
objects 

• Objects that are not full width capable need to be placed in the 
Responsive Row widget which is a special section that can also contain 
other full width objects if required. 

• Objects within a section always remain inside the section no matter on 
what device they are displayed upon. 

Responsive Pages on Different Devices 
When designing your website you may not necessarily want all objects on the 
page to be displayed on all devices. Alternatively you may want to replace one 
object with a different object depending on the device which the page is 
being viewed upon. 

To enable this, use the ‘Show on Device’ options in the Responsive section of 
the Metrics Inspector.  

Breakpoints 
EverWeb also lets you customize the point at which a device is regarded as one 
type or another. Breakpoints set the page width at which a device display will 
change from one type to another. Click on the ‘Breakpoints’ button in the 
Responsive section of the Metrics Inspector to set the breakpoints for mobile, 
tablet and desktop devices. Use the ‘Set Default’ button in the Breakpoints 
dialog box to reset the values back to their initial defaults. 
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The Editor Window displays breakpoints as dashed vertical lines. You can 
toggle the view of the breakpoints on and off using the Window-> Hide/Show 
Breakpoints menu option. 

Hidden Objects 
To locate a hidden object, secondary click on the responsive page. In the 
menu, scroll to the ‘Hidden Objects’ section and choose the object that you 
want to work with. The object will be displayed showing the objects contents. 
The selected box will be displayed with a grey background and a ‘X’ cross 
through it. The object will disappear when you click elsewhere on the canvas 
unless you have Window-> Show Hidden Objects set. In this instance, the 
contents of the selected hidden object will disappear leaving the grey box with 
the ‘X’ cross through it left in tact. 

Use the Window-> Show Hidden Objects menu option to display the location 
of all hidden objects on the page. 
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Sections Create the Structure of Responsive Pages. 
In the example in Figure 13.6, the web page on the left has been broken down 
in to its component parts as shown on the right. The objects within each 
horizontal section are represented in diagram on the right. 

Some objects can be a section in their own right e.g. the TextBox shown in the 
fourth section down from the top in Figure 13.6 above.  

Objects can also be placed within a section e.g. in the second section down 
from the top of Figure 13.6, the large logo on the left, text in the middle and 
button on the right have been placed within a Responsive Row widget. 

As a page can be viewed on different devices such as a mobile phone or 
desktop, sections automatically scale to display properly on each device. 
Objects inside the section also adjust their relative positions within the section 
in order to display correctly. 

For example, the objects within the green/blue rectangle section of Figure 13.6 
i are displayed as if being viewed on a desktop device. 

On a mobile device the objects may look like how the appear on the left in 
Figure 13.7. On the right is the diagrammatic representation of the objects in 
the section. The section and the three objects it contains are the same as they 
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were on the desktop, but their height and widths have scaled automatically to 
fit the mobile device the page is being displayed upon. 

 
Adding Objects To A Responsive Page 
When you drag and drop an object on to a responsive page layout, if the object 
is Full Width ‘capable’ it will be added as a Full Width and will become a 
sectioning its own right 

Full Width objects may also be placed in the Responsive Row widget as 
required e.g. if you want to add top and bottom padding to the Full Width 
object  
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Figure 13.7: The Responsive page on a mobile device automatically scales to display correctly on the 
device as can be seen on the page on the left and its diagrammatic representation on the right.
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Objects that are not Full Width capable, such as the PayPal widget, should 
always placed in a Responsive Row Widget so that they work properly. 

Adding New Sections To The Page 
You can add a new section object to the page just by dragging and dropping it 
the location where you want it placed. 

Moving Sections On The Page 
You can easily reorder sections on your page. Just drag and drop the section 
you want to move to its new location. 

Deleting A Section Form The Page 
To remove a section from the page select the section (you may need to use 
Pick Layer to make sure you have selected the right section) then press the 
backspace key on your keyboard. When you delete a section all of the objects 
inside the section will also be deleted. 
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Setting Section Margins 
Section objects can have their left and right 
margins set. This can be useful as otherwise a 
section object may be too close to the page 
margins. To set a section margin: 

1. Select the section object that you want to 
apply a left and/or right margins to.  

2. Go to the Metrics Inspector (see Figure 13.8). 

3. Set the left and right margins as required. 
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Figure 13.8: The Metrics Inspector 
showing the Left and Right Margin 

settings that can be applied to Full Width 
objects.
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Widgets & Responsive Pages 
Widgets play an important role in responsive design in EverWeb. Widgets can 
either be Responsive Only, Responsive Ready or require embedding in the 
Responsive Row widget in order to work properly in responsive pages. 

Responsive Only Widgets 
EverWeb includes some widgets specifically designed to be used only in a 
responsive page layout e.g. the Responsive Row, FlexBox, Text Sections and 
Responsive Gallery widgets. These widgets offer special layouts, features and 
effects that are scaleable for any device from mobile phone to wide desktop. 

Whilst these widgets be used in other page layouts, this is not recommended 
or supported as the widgets may be have unpredictably. 

The Responsive Row widget is a special EverWeb widget that is used 
extensively in responsive web page design as it includes special features to 
help you more easily create your responsive website. 

The Responsive Row Widget 
The Responsive Row widget is the cornerstone of your Responsive website 
design. The ResponsiveRow widget is important as it can contain TextBoxes, 
images, shapes and other widgets in it. 

Adding a Responsive Row Widget To The Page 
To add a Responsive Row Widget to the page go to the Widgets tab and drag 
and drop it on to the page. You can add as many Responsive Row widgets to 
your page as you want. 

When you add the widget to the page, you will see that it is Full Width. The 
widget displays the following instructions within it (See Figure 13.7): 
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Naming A Responsive Row Widget 
When you drag and drop a Responsive Row widget on to the page, its Widget 
Settings will be displayed in the Inspector Window. You can use the 
‘Responsive Row Name’ field in the Widget Settings to name the Responsive 
Row as you want. For example, you could name a Responsive Row in the 
Footer section of the page as ‘Footer Row’. 

Selecting A Responsive Row Widget 
To select a Responsive Row widget, just click on it. If there are objects already 
in the Responsive Row widget, click on an area of the widget where there are 
no objects. 

To confirm that the Responsive Row widget has been selected, secondary click 
on the widget. On the menu that appears mouse down to ‘Pick Layer’. If the 
Responsive Row is currently selected, Pick Layer should show ‘Responsive Row’ 
check marked. 

If the Responsive Row has not been selected, use Pick Layer to select it. From 
the Pick Layer menu, click on Responsive Row. 

Selecting the Responsive Row is important when you want to move the 
widget up and down your page, which is discussed below. 
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Figure 13.7: If you change the Page Layout from one type to another, EverWeb will warn you first as 
making a change to the page layout cannot be undone afterwards.
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Adding Objects In To A Responsive Row Widget 
As the instructions state, you can now drag and drop objects in to the widget. 
These objects can be either Full Width e.g. a Navigation Menu Widget or non-
Full Width such as the PayPal Widget, a TextBox, Image file and so on. 

When adding objects in to the Responsive Row Widget, make sure that the 
Responsive Row Widget is first selected. If the widget is not select, it is possible 
that when you add objects, they actually fall outside of the Responsive Row 
widget. Refer to the next paragraph if this Is the case. 

Moving Objects Into A Responsive Row Widget 
If for example the Responsive Row widget is not selected and you wanted to 
add a new TextBox into the widget, this will not happen and the TextBox will 
be displayed at the bottom of the page as a Full Width object instead. To move 
the TextBox into the Responsive Row widget, select the TextBox and then 
secondary click. Go to the ‘Embed In’ option and select the Responsive Row 
you want to place the TextBox inside of. The TextBox will be placed inside the 
Responsive Row widget. If the TextBox is not to be full width, uncheck the Full 
Width box in the Metrics Inspector.  

Moving Objects Within A Responsive Row Widget 
When you add objects to the Responsive Row Widget, you may want to 
rearrange their order. You can do this by dragging the object you want to 
move either to the left or right, and/.or up and down if necessary, within the 
Responsive Row until it is in the place that you want it to be. Drop the object 
into its new position.  

When moving objects within a Responsive Row Widget, you will see blue 
vertical guide lines that show you where the vertical border of the objects are. 
These guides help you position the object you are moving more easily. 

Deleting Objects From Inside A Responsive Row Widget 
To delete an object from within the Responsive Row Widget, select the object 
and press the backspace key on your keyboard. 
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Deleting A Responsive Row Widget 
To delete the Responsive Row widget, click on the widget itself or use Pick 
Layer to select the widget. Press backspace to delete the widget. Note that 
when you delete the Responsive Row widget that any object that it contains 
will also be deleted. Caution is advised when deleting the widget in case you 
actually only wanted to delete an object within the widget. 

If you delete the widget by mistake, use Cmd+Z 
to undo the action. 

Responsive Row Widget Settings 
The Responsive Row widget has the following 
settings that can be used to adjust various 
aspects of the objects that are contained in the 
Responsive Row widget (see Figure 13.8): 

Responsive Row Name 
By default, each Responsive Row is named as 
‘Responsive Row’. When you use the ‘Embed In’ 
option, you see a list of all the Responsive Row 
widgets that are on the page e.g. ‘Responsive 
Row 1’, ‘Responsive Row 2’ etc.  

If you have a large number of  Responsive Row 
widgets on your page it can become confusing 
when trying to embed an object in to the right 
Responsive Row. Therefore giving your 
Responsive Rows widgets a descriptive name 
will help make it easier to embed an object in to 
the correct Responsive Row widget. 

Alignment 
Objects within the Responsive Row widget 
can be aligned vertically and horizontally. 

Vertical 
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Figure 13.8:The Responsive Row Widget 
Settings
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Objects cam be aligned to the Top, Bottom or Middle of the Responsive Row 
Widget. 

Horizontal 

Objects can be aligned to the left, center or right in the widget. Objects can 
also be evenly spaced in the widget using the Justify option, or evenly spaced 
from the center point of the widget using the Justify Center option. 

Padding 
Use ‘Padding’ to add space at the ‘Top’ and ‘Bottom’ of the widget.  

Embedded Object Settings 
Use the ‘Insert Margin’ option to add vertical and horizontal padding between 
each of the objects inside of the Responsive Row widget. This ‘Insert Margin’ 
option is like the Insert Margin in the Text Inspector and helps enhance the 
display layout of objects within a Responsive Row. 

Testing Your Responsive Page 
Testing your responsive page should always be carried out as you will need to 
see if the page displays correctly on desktop, tablet and mobile devices. Often 
you can use EverWeb’s Preview feature to test how the page will look. 

Alternatively you can use responsive features within browsers such as Apple’s 
Safari web browser which includes responsive preview in its developer menu. 
There is also Apple’s Simulator which is part of Xcode that will simulate 
different Apple devices. This is available free from the Apple Developer website. 
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Responsive Blogging 

EverWeb includes a Responsive Blog that is available from the Blank 
Responsive Theme Template. To add the Responsive Blog to your website: 

1. Click on the Add Page button 

2. The Theme Template Chooser will appear. In the left hand column, 
select the 'Blank Responsive’ Theme Theme template which is the 
second Theme Template in the list. 

3. Once you have selected the Theme Template, click on the ‘blog’ page 
style on the right hand side and then click ‘Select’. 

4. The Responsive blog has been added to your website project. 

Converting an Existing Blog to a Responsive Blog 
If you have an existing Fixed Width layout blog, you can convert it to a 
responsive blog. Before converting your blog it is recommended that you 
backup your website project file in case you want to revert back to the original 
fixed width blog later. 

To convert a blog, change the format of the Page Layout from the current 
layout to ‘Responsive’ for the blog main, archive and posts pages. 
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14Contact Forms 
Enhanced Addon

This chapter introduces you to EverWeb;’s Contact Forms 
Enhanced Addon which is for use with the Contact Form 
Advanced widget. 

You will learn how to purchase and use the Contact Forms 
Enhanced Addon so you can manage and generate 
reporting from your Contact Form Submissions.

What is Contact Forms Enhanced Addon

Purchasing and Installing Contact Forms Enhanced Addon

How To Use CFE Addon in the Contact Form Advanced 
Widget

Adding File Upload Capability To Your Contact Form

Managing and Reporting Form Submissions

Selecting a Form to View Form Submissions & Selecting 
Form Submissions 

Sorting & Searching Form Submission Data

Displaying The Number of Form Submissions Per Page

Downloading Uploaded Files
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Contact Forms Enhanced Addon 

EverWeb’s Contact Forms Enhanced Addon (CFE) allows you to manage a 
database of contact information created from the contact forms visitors to 
your website have submitted via the Contact Form Advanced widget.  

The data in the contact form that the user sends you is known as a Form 
Submission. Visitor data is stored securely in your EverWeb Client Area where 
it is easily accessible and can be downloaded, if needed, to a CSV file. 

You can use Contact Forms Enhanced Addon to store email addresses 
gathered from your contact forms to help you create mail shots to existing and 
potential new customers, newsletter email lists, surveys, promotions and so on. 
You can also target specific groups or market segments based on questions 
you ask in your contact form. There are countless possibilities! 

Each contact form can have its own unique Contact Form Name so, for 
example, you could name a form for a survey, promotion, newsletter 
subscription and so on . 

Contact Forms Enhanced also allows visitors to upload files to the server which 
you can then later download safely from your EverWeb Client Area. 
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Purchasing & Installing Contact Forms 
Enhanced Addon 
To purchase and use Contact Forms Enhanced Addon, follow the steps below:1.  

1. Visit our Secure Online Store and purchase the Contact Forms Enhanced 
package you need. You can upgrade/downgrade at time for more 
submissions or file upload space. 

2. Once you have completed your purchase and your account is activated, you 
will receive an email with the Subject 'Contact Forms Enhanced Setup 
Instructions' 

3. Now, simply select your existing Contact Forms, or add a new one to any 
page. From the Inspector go to to the Widget Settings tab and select the 
'Contact Forms Enhanced Add-ons' field from the top of the Inspector (See 
Figure 14.1).  
 
Note: If you do not see any options listed, quit and relaunch EverWeb and make sure you 
are signed in from the EverWeb Preferences window. 
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Figure 14.1:The Contact Forms Enhanced Add-ons field 
in the Contact Form Advanced Widget Settings
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How To Use Contact Forms Enhanced 
Addon in Your Contact Form 
With Contact Forms Enhanced Addon enabled, go to the 'Contact Form 
Name (Online Management)' field and name the form appropriately. If you 
have more than one website, you may want to include the project file’s name 
in this field as well. This will make identifying forms easier when managing and 
reporting form submissions (See Figure 14.2). 

This name is used within your Client Area in order to separate and easily 
identify each contact form you have created. 

Adding 'File Upload' Capability To Your Contact Form 
If you want your website visitors to be able to upload files to you, add a new 
Form Control to the contact form by clicking on the 'Add' button in the Form 
Controls section of the Widget Settings tab (See Figure 14.3).  
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Figure 14.2:The Contact Form Name (Online Management) 
field in the Contact Form Advanced Widget Settings
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Name the Form Control and set the 'Control Type’ option to 'File Upload'. The 
contact form will update to display a 'Choose File' button. 

You can download files that your visitors have sent you from the Contact 
Forms Enhanced page in your EverWeb Client Area (see below). 
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Figure 14.3:Adding a Form Control so that your visitors can upload 
files from within the contact form.
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Managing and Reporting Form Submissions 

Once you have set up the contact form, publish the website. When a visitor 
submits a form, you will receive an it in the email box that you setup in the 
'Email Address to Send Form to' field of the contact form. 

To go to the Custom Form Enhanced page, either click on the link in the email 
to go to your EverWeb Client Area, or log in directly to your EverWeb Client 
Area (See Figure 14.4).  

www.everwebapp.com  of 204 207



EverWeb User Manual Responsive Websites in EverWeb

On the home screen of your EverWeb Client Area is the 'Contact Form 
Submissions' section on the left hand size. Click on 'View Form Submissions' to 
go to your form submission data. 

The 'Contact Forms Enhanced' page will be displayed with a summary at the 
top showing you the number of forms that have had form submissions, the 
total number of form submissions and the server space used by file uploads 
from your form responders.  

Selecting a Form to View Form Submissions 
To view your form submissions, click on the 'Please select your form to access 
its submissions' dropdown menu. A list of your forms will be displayed. 
Highlight the form you want then click on the 'Select' button. 

Selecting Form Submissions 
If you want to select all the form submissions tick the box at the top of the left 
most column heading. Check the box again to deselect all form submissions.  

To select or deselect form submissions, check or uncheck the selection box on 
the left hand side of each individual form submission. 

Exporting Form Submission Data 
Once you have selected the form you want, you will see the form submissions  

that have been submitted displayed. To export all of the form submission data 
of the form, click on the 'Export' button. 

To select a custom list of form submissions to export, check or uncheck the box 
next to each form submission that you want. Use the checkbox on the left 
hand side of the column headings to toggle select all forms on or off. Once you 
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Figure 14.4:The Contact Forms Enhanced page in your EverWeb Client Area is where form submission data from 
your contact forms is displayed and managed.
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have the form submissions that you want to export selected, click on the ‘With 
Selected’ button at the bottom of the list and select ‘Export’. 

Deleting Form Submission Data 
If you want to delete the form and all of its form submissions, click on the 
‘Delete Entire Form’ button. You will be asked to confirm the deletion.  

To select a custom list of form submissions to delete, check or uncheck the box 
next to each form submission that you want. Use the checkbox on the left 
hand side of the column headings to toggle select all form submissions on or 
off.  

Once you have selected the form submissions that you want to delete, click on 
the ‘With Selected’ button at the bottom of the list and select ‘Delete’. You will 
be asked to confirm the deletion. 

To delete form submissions individually, click on the Trashcan icon on the right 
hand side of the form submission that you want to delete. The trashcan icon is 
in the second last column of the form submission table so you may have to 
scroll the table horizontally to see it. 

You will be asked to confirm the deletion. 

Sorting Form Submission Data 
Use the Up/Down arrows next to any of the column headings to order your 
form submissions based on that column in ascending or descending order. An 
arrow icon together with an ascending/descending graph icon indicates which 
column the data is sorted upon and whether it is in ascending or descending 
order. 

Searching Form Submission Data 
To search within your form submission data just enter the criteria you want in 
the search box then press Enter e.g. you could select '2019-07' to select all 
forms submitted in July 2019. 
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Displaying The Number of Form Submissions Per Page 
At the bottom of the Contact Forms Enhanced page is where you can select 
how many form submissions per page you want to see. The default is 10, but 
you can also choose either 25, 50 or 'All'. 

Downloading File Uploads Submitted By Your Visitors 
Files that have been uploaded will be displayed in the ‘Attachments’ column. A 
down arrow within a circle icon indicates that a file has been uploaded. To 
download the file to your computer, just click on the icon. The file will be 
downloaded to your Downloads folder. 

If you do not see the Attachments column, scroll the table horizontally to the 
left so that the columns on the right hand side of the form submissions table 
come in to view.
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